
 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

1 

 

MBA – I YEAR 

DKR17 : COMPUTER APPLICATION IN MANAGEMENT 

SYLLABUS 

 

Unit I  

  Computers – Introduction – Computers in business – Elements of computer systems 

setup; Indian computing environment; components of a computer system; generations of 

computers and computer languages.  

 

Unit II  

  Personal computers in business – PC software packages – introduction – Disk Operating 

system and windows.  

 

Unit III  

  Word Processing Software – Creating document – File management – Editing – 

formatting – Using tools – Tables – Working within tables. 

 

Unit IV 

  Spreadsheet software – Introduction – Creation of spreadsheet application; range, 

formula, functions database functions in spreadsheet – Graphics on spreadsheet.  

 

Unit V 

  Managerial applications of computers – Computer and management functions – 

Computer based financial accounting systems – Inventory systems – Computerised MIS and 

control systems.  

 

References :  

1. Summer M. – Computer Concepts and Uses (PHI)  

2. Long, L. – Computers (PHI)  

3. David. Van Over – Foundation of Business systems (Dryden) 

 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

2 

 

COMPUTER APPLICATION IN MANAGEMENT 

UNIT 1 – COMPUTERS – INTRODUCTION................................................................................................................ 7 

WORKING PRINCIPLE OF COMPUTER ................................................................................................................................. 7 

COMPUTER CLASSIFICATION: BY SIZE AND POWER ............................................................................................................... 8 

COMPUTERS IN BUSINESS ...................................................................................................................................... 8 

ELEMENTS OF COMPUTER SYSTEMS SETUP ........................................................................................................... 9 

(I) HARDWARE .............................................................................................................................................................. 9 

(II) SOFTWARE .............................................................................................................................................................. 9 

(III) PEOPLE ................................................................................................................................................................ 11 

(IV) DATA .................................................................................................................................................................. 11 

(V) CONNECTIVITY: ...................................................................................................................................................... 11 

INDIAN COMPUTING ENVIRONMENT .................................................................................................................. 12 

COMPONENTS OF A COMPUTER SYSTEM ............................................................................................................ 13 

KEYBOARD ................................................................................................................................................................. 15 

MOUSE ..................................................................................................................................................................... 16 

JOYSTICK .................................................................................................................................................................... 16 

LIGHT PEN ................................................................................................................................................................. 17 

TRACK BALL ................................................................................................................................................................ 17 

SCANNER ................................................................................................................................................................... 17 

DIGITIZER ................................................................................................................................................................... 17 

MICROPHONE ............................................................................................................................................................. 18 

MAGNETIC INK CARD READER (MICR) ............................................................................................................................ 18 

OPTICAL CHARACTER READER (OCR) .............................................................................................................................. 18 

BAR CODE READERS ..................................................................................................................................................... 18 

OPTICAL MARK READER (OMR) .................................................................................................................................... 18 

MONITORS ................................................................................................................................................................. 19 

PRINTERS ................................................................................................................................................................... 20 

IMPACT PRINTERS ........................................................................................................................................................ 20 

NON-IMPACT PRINTERS ................................................................................................................................................ 21 

PLOTTER .................................................................................................................................................................... 22 

SPEAKER: ................................................................................................................................................................... 23 

CACHE MEMORY ......................................................................................................................................................... 23 

PRIMARY MEMORY (MAIN MEMORY) ............................................................................................................................. 24 

SECONDARY MEMORY .................................................................................................................................................. 24 

GENERATION OF COMPUTER ............................................................................................................................... 25 

FIRST GENERATION ...................................................................................................................................................... 25 

SECOND GENERATION .................................................................................................................................................. 26 

THIRD GENERATION ..................................................................................................................................................... 27 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

3 

 

FOURTH GENERATION ................................................................................................................................................... 28 

FIFTH GENERATION ...................................................................................................................................................... 29 

COMPUTER LANGUAGES...................................................................................................................................... 30 

1. LOW LEVEL LANGUAGE: ............................................................................................................................................ 30 

2. HIGH LEVEL LANGUAGE ............................................................................................................................................ 30 

UNIT II - PERSONAL COMPUTERS IN BUSINESS .................................................................................................... 32 

COMPUTERS IN BUSINESS .............................................................................................................................................. 32 

PC SOFTWARE PACKAGES: INTRODUCTION ......................................................................................................... 33 

DISK OPERATING SYSTEM (DOS) .......................................................................................................................... 33 

PATHNAME ................................................................................................................................................................ 35 

LOADING DOS ............................................................................................................................................................ 35 

LOADING DOS THROUGH WINDOWS .............................................................................................................................. 36 

FILE NAMING CONVENTIONS ......................................................................................................................................... 37 

1. DISPLAYING A LIST OF FILES ON THE DISK: DIR COMMAND ............................................................................................... 39 

2. MAKING A DIRECTORY: MD COMMAND ...................................................................................................................... 40 

3. REMOVING A DIRECTORY: RD COMMAND .................................................................................................................... 40 

4. CHANGING DIRECTORY: CD COMMAND ....................................................................................................................... 41 

1. COPYING FILES: THE COPY COMMAND ....................................................................................................................... 42 

2. DELETING FILES: DEL COMMAND ............................................................................................................................... 43 

3. RENAMING FILES: REN COMMAND ............................................................................................................................. 44 

(A) DISPLAYING AND/OR CHANGING DATE: THE DATE COMMAND ....................................................................................... 47 

(B) DISPLAYING AND/OR CHANGING THE CURRENT TIME: THE TIME COMMAND ..................................................................... 47 

WINDOWS ........................................................................................................................................................... 48 

MY COMPUTER ........................................................................................................................................................... 49 

RECYCLE BIN ............................................................................................................................................................... 50 

ACTIVE WINDOW ........................................................................................................................................................ 51 

1. THE PROGRAM MENU .............................................................................................................................................. 51 

2. THE DOCUMENT MENU ............................................................................................................................................ 52 

3. THE SETTINGS MENU ............................................................................................................................................... 52 

4. THE FIND COMMAND ............................................................................................................................................... 52 

5. THE HELP COMMAND ............................................................................................................................................... 52 

6. THE RUN COMMAND ............................................................................................................................................... 52 

7. THE SHUTDOWN COMMAND ..................................................................................................................................... 52 

(A) RENAMING A FILE OR A FOLDER ................................................................................................................................. 57 

(B) DELETING A FILE OR FOLDER ..................................................................................................................................... 57 

(C) MOVING A FILE ...................................................................................................................................................... 58 

(D) COPYING A FILE TO A EXTERNAL STORAGE .................................................................................................................... 58 

(E) CREATING A NEW FOLDER ......................................................................................................................................... 58 

CREATING DOCUMENT: MS WORD ...................................................................................................................... 62 

FILE MENU ................................................................................................................................................................. 64 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

4 

 

EDIT MENU ................................................................................................................................................................ 64 

VIEW MENU ............................................................................................................................................................... 65 

INSERT MENU ............................................................................................................................................................. 65 

FORMAT MENU .......................................................................................................................................................... 66 

TOOLS MENU ............................................................................................................................................................. 66 

TABLE MENU .............................................................................................................................................................. 66 

WINDOW MENU ......................................................................................................................................................... 67 

HELP MENU ............................................................................................................................................................... 67 

FILE MANAGEMENT ............................................................................................................................................. 67 

CREATION OF A NEW DOCUMENT ................................................................................................................................... 67 

OPENING A DOCUMENT ................................................................................................................................................ 68 

SAVING A DOCUMENT .................................................................................................................................................. 69 

CLOSING A DOCUMENT................................................................................................................................................. 70 

EXITING WORD 2000 .................................................................................................................................................. 70 

EDITING ............................................................................................................................................................... 70 

SELECTING TEXT .......................................................................................................................................................... 71 

INSERTING TEXT .......................................................................................................................................................... 72 

COPYING TEXT ............................................................................................................................................................ 72 

MOVING TEXT ............................................................................................................................................................ 73 

DELETING TEXT ........................................................................................................................................................... 73 

UNDO ....................................................................................................................................................................... 74 

REDO ........................................................................................................................................................................ 74 

FORMATTING....................................................................................................................................................... 74 

DEFINING FONT TYPE AND SIZE OF TEXT .......................................................................................................................... 75 

MAKING TEXT BOLD, ITALIC AND UNDERLINED .................................................................................................................. 77 

CHANGING CASE OF TEXT .............................................................................................................................................. 78 

ALIGNMENT OF TEXT .................................................................................................................................................... 78 

BULLETS AND NUMBERING ............................................................................................................................................ 80 

INSERTING CLIPS .......................................................................................................................................................... 83 

RESIZING CLIPS ........................................................................................................................................................... 84 

MARGIN SETTING THROUGH FILE/PAGE SETUP ................................................................................................................. 85 

SETTING MARGINS USING RULER LINE ............................................................................................................................. 85 

CREATING HEADERS/FOOTERS ........................................................................................................................................ 86 

USING TOOLS ....................................................................................................................................................... 87 

CHECKING SPELLING AND GRAMMAR AS YOU GO ................................................................................................................ 88 

SPELLING AND GRAMMAR DIALOG BOX OPTIONS ................................................................................................................ 89 

TABLES ................................................................................................................................................................. 91 

WORKING WITHIN TABLES ................................................................................................................................... 91 

INTRODUCTION ................................................................................................................................................... 94 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

5 

 

CREATION OF SPREADSHEET APPLICATION: MS EXCEL......................................................................................... 95 

THE DATA AREA ........................................................................................................................................................... 98 

TO MOVE THE ACTIVE CELL: ........................................................................................................................................... 99 

TO CREATE A TEXT LABEL: .............................................................................................................................................. 99 

TO RESIZE COLUMNS AND ROWS: .................................................................................................................................... 99 

MOVING AND COPYING TEXT ....................................................................................................................................... 100 

INSERTING A ROW ..................................................................................................................................................... 101 

INSERTING A COLUMN ................................................................................................................................................ 101 

DELETING A CELL OR GROUP OF CELLS ........................................................................................................................... 101 

CLEARING THE CONTENTS OF A CELL OR GROUP OF CELLS.................................................................................................. 101 

AUTOFILL ................................................................................................................................................................. 102 

FORMULA .......................................................................................................................................................... 102 

SOME COMMON FORMULAE ........................................................................................................................................ 103 

THE ORDER OF PRECEDENCE ......................................................................................................................................... 104 

VIEWING DATES AS NUMBERS ...................................................................................................................................... 104 

CALCULATING THE DIFFERENCE BETWEEN TWO DATES ....................................................................................................... 105 

COPYING FORMULAE .................................................................................................................................................. 105 

USING THE FILL HANDLE .............................................................................................................................................. 106 

USING KEYSTROKES .................................................................................................................................................... 106 

FUNCTIONS ........................................................................................................................................................ 107 

FUNCTIONS AND ARGUMENTS ...................................................................................................................................... 107 

AUTOSUM ............................................................................................................................................................... 108 

SETTING THE PRECISION OF NUMBER FORMATS ................................................................................................................ 110 

RANGE ............................................................................................................................................................... 111 

ABSOLUTE CELL REFERENCING ...................................................................................................................................... 112 

MAKING A REFERENCE ABSOLUTE .................................................................................................................................. 112 

MAKING A MIXED REFERENCE ....................................................................................................................................... 113 

DEFAULT NAMES ....................................................................................................................................................... 114 

NAMING RULES ......................................................................................................................................................... 114 

CREATING A NAME .................................................................................................................................................... 114 

DEFINING NAMES ...................................................................................................................................................... 115 

CREATING MULTIPLE NAMES ........................................................................................................................................ 116 

SELECTING NAMES ..................................................................................................................................................... 116 

NAMES IN FORMULAE ................................................................................................................................................. 117 

APPLYING NAMES ...................................................................................................................................................... 117 

DELETING NAMES ...................................................................................................................................................... 118 

PASTE LIST ............................................................................................................................................................... 118 

COUNTING AND TOTALING CELLS CONDITIONALLY ............................................................................................................. 119 

SUMIF() ................................................................................................................................................................. 119 

COUNTIF() ............................................................................................................................................................. 119 

TYPICAL ERRORS AND THEIR CAUSES .............................................................................................................................. 121 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

6 

 

DATABASE FUNCTIONS IN SPREADSHEET ........................................................................................................... 122 

GRAPHICS ON SPREADSHEET ............................................................................................................................. 123 

SELECTING DATA FOR AN EXCEL CHART .......................................................................................................................... 125 

HOW TO DELETE A CHART ........................................................................................................................................... 128 

HOW TO MOVE A CHART ............................................................................................................................................ 128 

HOW TO RESIZE A CHART ............................................................................................................................................ 128 

EXCEL CHART HELPFUL HINTS ...................................................................................................................................... 128 

COMPUTERS AND MANAGEMENT FUNCTIONS .................................................................................................. 129 

DATA MANAGEMENT ................................................................................................................................................. 129 

OFFICE AND SUPPLY MANAGEMENT .............................................................................................................................. 129 

PEOPLE MANAGEMENT .............................................................................................................................................. 130 

RECORD KEEPING AND ACCOUNTING ............................................................................................................................. 130 

COMPUTER BASED FINANCIAL ACCOUNTING SYSTEM ....................................................................................... 130 

THE ACCOUNTING SYSTEM .......................................................................................................................................... 131 

SALIENT FEATURES OF COMPUTERIZED ACCOUNTING ........................................................................................................ 132 

COMPUTERISED INVENTORY CONTROL SYSTEM ................................................................................................ 133 

COMPUTERIZED MIS AND CONTROL SYSTEM .................................................................................................... 134 

MANAGEMENT ......................................................................................................................................................... 135 

INFORMATION .......................................................................................................................................................... 135 

SYSTEM ................................................................................................................................................................... 135 

  



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

7 

 

UNIT 1 – COMPUTERS – INTRODUCTION 

Computers have touched every part of our lives: the way we work, the way we 

learn, the way we live, even the way we play. It almost is impossible to go through a 

single day without encountering a computer or a device dependent on a computer or 

information produced by a computer. Because of the significance of computers in today‘s 

world, it is important to be computer literate  

What is computer? 

A computer is a fast electronic device that processes the input data according to 

the instructions given by the programmer/user and provides the desired information as an 

output. 

Data is a collection of raw unprocessed facts, figures, and 

symbols. Information is data that is organized, meaningful, and useful. To process data 

into information, a computer uses hardware and software. Hardware is the electric, 

electronic, and mechanical equipment that makes up a computer. Software is the series 

of instructions that tells the hardware how to perform tasks. 

Working Principle of Computer 

 Computer is an electronic device that accepts the input, process the data and 

produces the output. 

 

 

Input: Input is the raw information (Data) entered into a computer from the input 

devices. It is the collection of letters, numbers, images etc. 

Process: Process is the operation on the data as per the given instruction. It is totally 

internal process of the computer system. 

Output: Output is the processed data given by computer after data processing. Output is 

also called as Result. We can save these results in the storage devices for the future use. 

Input Process Output 
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Computer Classification: By Size and Power 

Most people associate a personal computer (PC) with the phrase computer.  A PC is a 

small and relatively inexpensive computer designed for an individual use. PCs are based 

on the microprocessor technology that enables manufacturers to put an entire CPU on one 

chip. Personal computers at home can be used for a number of different applications 

including games, word processing, accounting and other tasks. 

Computers are generally classified by size and power as follows, although there is 

considerable overlap. The differences between computer classifications generally get 

smaller as technology advances, creating smaller and more powerful and cost-friendly 

components. 

 Personal computer: a small, single-user computer based on a microprocessor. In 

addition to the microprocessor, a personal computer has a keyboard for entering data, 

a monitor for displaying information, and a storage device for saving data. 

 Workstation: a powerful, single-user computer. A workstation is like a personal 

computer, but it has a more powerful microprocessor and a higher-quality monitor. 

 Minicomputer: a multi-user computer capable of supporting from 10 to hundreds of 

users simultaneously. 

 Mainframe: a powerful multi-user computer capable of supporting many hundreds or 

thousands of users simultaneously. 

 Supercomputer: an extremely fast computer that can perform hundreds of millions 

of instructions per second. 

COMPUTERS IN BUSINESS  

Computers can process vast quantities of business data at enormous speed with 

unfailing consistency and unimaginable flexibility. These capabilities of computers offers 

new approaches to problem solving and data processing. 

Following six characteristics of computers make them indispensable for use in business: 

(a) Speed: Computers speed up data processing by many orders of magnitude as 

compared to the manual system. 

(b) Data Volume: Vast amount of data can be stored and processed very quickly. 

(c) Repetitiveness: The more repetitive the task, the more profitable it is to automate it. 
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(d) Complexity: Problems with several interacting variables can be solved quickly and 

accurately. 

(e) Accurate Output: High accuracy can be obtained as needed; also accuracy is not 

affected by boredom and fatigue and is not Subjective. ' 

(f) Declining Costs: There has been a steady decline in the cost of per unit of data 

processed. 

ELEMENTS OF COMPUTER SYSTEMS SETUP 

A computer system setup consists of five elements viz.: 

 

i. Hardware 

ii. Software 

iii. People 

iv. Data  

v. Connectivity. 

(i) Hardware 

The physical components of a computer constitute its Hardware. Hardware 

consists of input devices and output devices that make a complete computer system. 

Examples of input devices are keyboard, optical scanner, mouse and joystick 

which are used to feed data into the computer. Output devices such as monitor and printer 

are media to get the output from the computer. 

(ii) Software 

A set of programs that form an interface between the hardware and the user of a 

computer system are referred to as Software. 

They are of two types of software: 

(a) System software 

A set of programs to control the internal operations of the computer such as 

reading data from input devices, giving results to output devices and ensuring proper 

functioning of components is called system software. 
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Example for system software are: 

1. Operating system 

A set of tools and programs to manage the overall working of a computer 

using a defined set of hardware components is called an operating system. It is the 

interface between the user and the computer system. 

2. Utility software 

Certain special purpose programs that are designed to perform a specialized 

task, such as functions to copy, cut or paste files in a computer, formatting a disk 

etc. 

3.  Language processors 

It‘s system software that accepts data in high level language (user 

understandable language) and interprets it to Machine /Assembly language 

(understandable by a computer). It also ensures the correctness of language syntax 

and errors.  

4. Connectivity software 

A set of programs and instructions to connect the computer with the 

network to enable sharing of resources and information with the server and other 

connected computers. 

(b)  Application software 

Application software includes programs that user‘s access to carry out 

work.  They include applications for the following functions. 

 Word processing is the most common applications software.  The great 

advantage of word processing over using a typewriter is that you can make 

changes without retyping the entire document.  Word processors make it 

easy to manipulate and format documents. 

 Spreadsheets are computer programs that let people electronically create 

and manipulate spreadsheets (tables of values arranged in rows and 

columns with predefined relationships to each other).  Spreadsheets are 

used for mathematical calculations such as accounts, budgets, analysis and 

so on. 
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 Database management applications are computer programs that let 

people create and manipulate data in a database.  A database is a collection 

of related information that can be manipulated and used to sort information, 

conduct statistical analyses or generate reports. 

 Presentation packages and graphics are computer programs that enable 

users to create highly stylised images for slide presentations and reports.  

They can also be used to produce various types of charts and graphs.  Many 

software applications include graphics components including: paint 

programs, desktop publishing applications and so on. 

 Communications applications typically include software to enable people 

to send faxes and emails and dial into other computers. 

 (iii) People 

The most important element of a computer system is its users. They are also called live-

ware of the computer system. 

The following types of people interact with a computer system: 

(a) System Analysts: Person who designs the operation and processing of the system  

(b) System Programmers: People who write codes and programs to implement   

the working of the system 

(c) System Operators/ End users: People who operates the system and use it for 

different purposes  

 (iv) Data 

The facts and figures that are fed into a computer for further processing are called 

data. Data is raw until the computer system interprets it using machine language, stores it 

in memory, classifies it for processing and produces results in conformance with the 

instructions given to it. Processed and useful data is called information which is used for 

decision making. 

(v) Connectivity: 

When two or more computers are connected to each other, they can share information 

and resources such as sharing of files (data/music etc.), sharing of printer, sharing of 
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facilities like the internet etc. This sharing is possible using wires, cables, satellite, infra-

red, Bluetooth, microwave transmission etc. 

INDIAN COMPUTING ENVIRONMENT 

Office work includes many administrative and management activities. The 

preparation, distribution, processing and review of documents are the common activities 

of an organization. Prior to the advent-of computers, these office activities were either 

performed manually or with the help of mechanical and electrical machines. During the 

past few decades, the basic nature of office has changed remarkably. Office automation 

deals in application of latest technologies in improving the overall proficiency of the 

office.  

Office Automation 

The word automation denotes replacement of human work by machine. The 

mechanical operations in office with less human participation are termed as automation. 

The word mechanization and automation should not be considered as synonymous. 

Mechanization refers to a process whereby office machines and equipments are 

introduced in the office with a view to aid administrative processes. 

But automation is something more than mechanization because automation is a 

self regulated process in which the work is completed with minimum human efforts. The 

self regulated process aims at continuous flow of information without minimum human 

intervention. So in brief the word automation denotes the art of recording, processing and 

controlling the information automatically by mechanical and electronic machine. 

Needs and Importance 

The need for automation is felt because of the following reasons.  

(a) Automation facilitates efficient and detailed information through the use of 

mechanical aids like computers. 

(b) It ensures speedy recording, processing and presenting of information. 

(c) Increased volume of work, scarcity of time and the slow manual processes necessitate 

the introduction of automation. 

(d) It facilitates better quality work by reducing errors which are created on manual work. 
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(e) Revolution in office has been brought by automation because increased volume of 

work is handled in a better manner with greater accuracy and speed which results in 

increased output. 

(f) Automation increases the goodwill and reputation of the firm since it adds to the 

prestige and status symbol of the enterprise. 

COMPONENTS OF A COMPUTER SYSTEM 

The basic components of a modern digital computer are: Input Unit, Central 

Processing Unit (CPU), Memory, Output unit, and Storage unit.  The Central Processing 

Unit consists of Control Unit and Arithmetic and Logical Unit.  

 

1. Input unit: The process of entering data and programs into the computer system is 

called input. The device that is used to give input to the system called Input Unit. Eg. 

Keyboard, Mouse, Touch Screen etc. 

2. System Unit: It is a box-like case made from metal or plastic that protects the internal 

electronic components of the computer from damage. The system unit contains the 

central processing unit and memory.  

Central Processing Unit (CPU): The central processing unit (CPU) is the electronic 

device that interprets and carries out the basic instructions that operate the 
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computer. It is the brain of the computer and it comprises of Arithmetic and 

Logical Unit and Control Unit.  

 Arithmetic Logic Unit (ALU): All the arithmetic and logical operation 

such as addition, subtraction, multiplication, division, logic and 

comparison are performed by this unit. 

 

 Control Unit (CU): The process of input, output, processing and storage is 

performed under the supervision of a unit called 'Control Unit'. It decides 

when to start receiving data, when to stop it, where to store data, etc. It 

takes care of step-by-step processing of all operations inside the computer. 

 

3. Memory Unit: This is the device that is used to store program and data. All the 

processed and intermediate results are also stored in the memory unit. Eg. RAM, ROM, 

cache memory.  

 

 4. Output Unit: The process of producing results from the data for getting useful 

information is called output. The device that is used to display the output is called output 

unit. Eg. Monitor, printer, plotter etc., 

5. Storage unit: The memory of a computer (RAM) only holds the items temporarily 

while they are being processed. When not being processed, these items must be stored in 

auxiliary storage devices. The devices that is used to store data and information for the 

future use is called storage unit. These devices include floppy disks, hard disks, CD-

ROM, and DVD-ROM.  

Input Devices 

An input device is any hardware component that allows a user to enter data and 

instructions into a computer. Different types of input devices transmit different types of 

data or transmit data in different ways. 

Following are few of the important input devices which are used in a computer: 

1. Keyboard 

2. Mouse 

3. Joy Stick 
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4. Light pen 

5. Track Ball 

6. Scanner 

7. Graphic Tablet 

8. Microphone 

9. Magnetic Ink Card Reader(MICR) 

10. Optical Character Reader(OCR) 

11. Bar Code Reader 

12. Optical Mark Reader(OMR) 

Keyboard 

Keyboard is the most common and very popular input device which helps in inputting 

data to the computer. The layout of the keyboard is like that of traditional typewriter, 

although there are some additional keys provided for performing additional functions. 

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 

108 keys are also available for Windows and Internet. 

The keys on the keyboard are as follows: 

S.No Keys Description 

1 Typing Keys These keys include the letter keys (A-Z) and digit keys 

(0-9) which generally give same layout as that of 

typewriters. 

2 Numeric Keypad It is used to enter numeric data or cursor movement. 

Generally, it consists of a set of 17 keys that are laid out 

in the same configuration used by most adding machines 

and calculators. 

3 Function Keys The twelve function keys are present on the keyboard 

which is arranged in a row at the top of the keyboard. 

Each function key has unique meaning and is used for 
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some specific purpose. 

4 Control keys These keys provide cursor and screen control. It includes 

four directional arrow keys. Control keys also include 

Home, End, Insert, Delete, Page Up, Page Down, 

Control(Ctrl), Alternate(Alt), Escape(Esc). 

5 Special Purpose Keys Keyboard also contains some special purpose keys such 

as Enter, Shift, Caps Lock, Num Lock, Space bar, Tab, 

and Print Screen. 

 

Mouse 

Mouse is most popular pointing device. It is a very famous cursor-control device 

having a small palm size box with a round ball at its base which senses the movement of 

mouse and sends corresponding signals to CPU when the mouse buttons are pressed. 

Generally it has two buttons called left and right button and a wheel is present between 

the buttons. Mouse can be used to control the position of cursor on screen, but it cannot 

be used to enter text into the computer. 

Advantages 

 Easy to use 

 Not very expensive 

 Moves the cursor faster than the arrow keys of keyboard. 

Joystick 

Joystick is also a pointing device which is used to move cursor position on a 

monitor screen. It is a stick having a spherical ball at its both lower and upper ends. The 

lower spherical ball moves in a socket. The joystick can be moved in all four directions. 
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The function of joystick is similar to that of a mouse. It is mainly used in Computer 

Aided Designing (CAD) and playing computer games. 

Light Pen 

Light pen is a pointing device which is similar to a pen. It is used to select a 

displayed menu item or draw pictures on the monitor screen. It consists of a photocell and 

an optical system placed in a small tube. When the tip of a light pen is moved over the 

monitor screen and the pen button is pressed, its photocell sensing element detects the 

screen location and sends the corresponding signal to the CPU. 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop computer, 

instead of a mouse. This is a ball which is half inserted and by moving fingers on ball, 

pointer can be moved. Since the whole device is not moved, a track ball requires less 

space than a mouse. A track ball comes in various shapes like a ball, a button and a 

square. 

Scanner 

Scanner is an input device which works more like a photocopy machine. It is used 

when some information is available on a paper and it is to be transferred to the hard disc 

of the computer for further manipulation. Scanner captures images from the source which 

are then converted into the digital form that can be stored on the disc. These images can 

be edited before they are printed. 

Digitizer 

Digitizer is an input device which converts analog information into digital form. 

Digitizer can convert a signal from the television or camera into a series of numbers that 

could be stored in a computer. Digitizer is also known as Tablet or Graphics Tablet 

because it converts graphics and pictorial data into binary inputs. A graphic tablet as 

digitizer is used for doing fine works of drawing and image manipulation applications. 
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Microphone 

Microphone is an input device which is used to input voice or sound in digital 

form. The microphone is used for various applications like adding sound to a multimedia 

presentation or for mixing music. 

Magnetic Ink Card Reader (MICR) 

MICR input device is generally used in banks because of a large number of 

cheques to be processed every day. The bank's 

code number and cheque number are printed on the 

cheques with a special type of ink that contains 

particles of magnetic material that are machine 

readable. This reading process is called Magnetic 

Ink Character Recognition (MICR). The main 

advantage of MICR is that it is fast and less error 

prone. 

Optical Character Reader (OCR) 

OCR is an input device used to read a printed text. OCR scans text optically 

character by character, converts them into a machine readable code and stores the text on 

the system memory. 

Bar Code Readers 

Bar Code Reader is a device used for reading bar coded data (data in form of light 

and dark lines). Bar coded data is generally used in labeling goods, numbering the books 

etc. It may be a hand held scanner or may be embedded in a stationary scanner. Bar Code 

Reader scans a bar code image, converts it into an alphanumeric value which is fed into 

the computer to which bar code reader is connected. 

Optical Mark Reader (OMR) 

OMR is a special type of optical scanner used to recognize the type of mark made 

by pen or pencil. It is used where one out of a few alternatives is to be selected and 

marked. It is specially used for checking the answer sheets of examinations having 

multiple choice questions. 

OUTPUT DEVICES 
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An output device is any hardware component that returns processed data that is 

information, back to the user. Some of the commonly used output devices are: 

 Monitors  

 Printers 

 Plotters 

 Speakers 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output 

device of a computer. It forms images from tiny dots, called pixels that are arranged in a 

rectangular form. The sharpness of the image depends upon the number of pixels. 

The quality of a monitor's display depends largely on three factors: 

 Resolution - the number of pixels displayed . Most monitors have a resolution of 

at least 800 x 600 pixels. High-end monitors can have resolutions of 1024 x 768 

pixels or even 1280 x 1024 pixels. Thus monitors are available either in low 

resolution or in high resolution. 

 Dot pitch - the distance between pixels 

 Refresh rate - the speed at which images are redrawn on the screen 

 

Types of monitors 

 Cathode-Ray Tube (CRT) 

 Flat- Panel Display 

Cathode-Ray Tube (CRT) Monitor 

CRT or Cathode Ray Tube Monitor is the typical monitor that seen on a desktop 

computer. It looks like a television screen, and works the same way. This type uses a 

large vacuum tube, called Cathode Ray Tube (CRT). The CRT 

display is made up of small picture elements called pixels. The 

smaller the pixels, the better the image clarity, or resolution.  

A finite number of characters can be displayed on a screen at 

once. The screen can be divided into a series of character 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

20 

 

boxes i.e a fixed location on the screen where a standard character can be placed. Most 

screens are capable of displaying 80 characters of data horizontally and 25 lines 

vertically. The disadvantages of CRT monitors are Large in Size and High power 

consumption 

Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices 

that have reduced volume, weight and power requirement in 

comparison to the CRT. Current uses of flat-panel displays 

include calculators, video games, monitors, laptop computer, 

graphics display. 

The flat-panel display is divided into two categories: 

 Emissive Displays - The emissive displays are devices that convert electrical 

energy into light. Examples are plasma panel and LED (Light-Emitting Diodes). 

 Non-Emissive Displays - The Non-emissive displays use optical effects to 

convert sunlight or light from some other source into graphics patterns. Example 

is LCD(Liquid-Crystal Device) 

Printers 

After a document is created on the computer, it can be sent to a printer for a hard 

copy (printout).  

There are two types of printers: 

 Impact Printers 

 Non-Impact Printers 

Impact Printers  

 The impact printers print the characters by striking them on the ribbon which is then 

pressed on the paper. So there is a physical contact with the paper to produce an image.  

Uses of Impact Printers 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 
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Non-Impact Printers  

Non-impact printers print the characters without using ribbon. So there is no physical 

contact with the paper. These printers print a complete page at a time so they are also 

called as Page Printers.  

Characteristics of Non-impact Printers 

 Faster than impact printers. 

 They are not noisy. 

 High quality. 

 Support many fonts and different character size. 

 

Some of the most commonly used printers are: 

1. Laser Printer 

2. Ink Jet Printer 

3. Dot Matrix Printer 

4. Line Printer 

Laser Printer:  Laser printers are non-impact page printers. They use laser lights to 

produce the dots needed to form the characters to be printed on a 

page. It produces high quality print that one normally finds in 

publishing. It is extremely fast and quiet. Moreover, the operation 

of a laser printer is easy with automatic paper loading and no 

smudging or messing up of ink ribbons. The fastest laser printer 

can print up to 200 pages per minute in monochrome (black and 

white) and up to 100 pages per minute in colour.  

Ink-Jet Printer: An ink-jet printer is a non-impact printer and it creates an image directly 

on paper by spraying ink through as many as 64 tiny nozzles. Although the image it 

produces is not generally quite as sharp as the output of a laser printer, the quality of ink-

jet images is still high. 

In general, ink-jet printer offers an excellent middle ground between dot matrix 

and laser printer. Like laser printer, an ink-jet printer is quiet and convenient, but not 
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particularly fast. Typically, an ink-jet printer is more expensive than a dot-matrix printer, 

but costs only half as much as a laser printer. Inkjet printers are non-impact character 

printers. They print characters by spraying small drops of ink onto paper. Inkjet printers 

produce high quality output with presentable features. 

Dot Matrix Printer: The dot matrix printer is an impact printer and was very popular at 

one point of time. It is a very versatile and inexpensive output 

device. In dot matrix printer the print head physically "hits" the 

paper through the ribbon and produces text (or images) by 

combinations of dots; hence the name dot matrix printer. Its 

speed is measured in characters per second (CPS). Although 

it is less expensive, it is louder, slower and produces lower 

print quality. 

Line Printer: A line printer is an impact printer and it is generally used with large 

computer systems to produce text based data processing reports. Line printers are high-  

speed printers with speeds ranging anywhere from 100 to 

about 3800 lines per minute. In the past, print quality on line 

printers was not high. Developments in technology are 

improving the print quality on line printers. 

 

Plotter 

A plotter is a special kind of output device that, like a printer, produces images on 

paper, but does so in a different way. Plotters are designed to produce large drawings or 

images, such as construction plans for buildings or blueprints for mechanical objects. A 

plotter can be connected to the port normally used by a printer. An array of different 

colored pens in a clip rack and a robotic arm is part of plotter. The instructions that a 

plotter receives from a computer consist of a color, and beginning and ending coordinates 

for a line. With that information, the plotter picks up the appropriate pen through its arm, 

positions it at the beginning coordinates drops the pen down to the surface of the paper 

and draws to the ending coordinates. Plotters draw curves by creating a sequence of very 

short straight lines. 

Plotters usually come in two designs: 

1. Flat Bed: Plotters of small size to be kept on table with restriction of paper size. 
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2. Drum: These plotters are of big size using rolls of paper of unlimited length. 

Speaker:  

Speakers are another type of output device, which allow you to listen to voice like 

music, and conversation with people. 

Memory 

A memory is just like a human brain. It is used to store data and instructions. Computer 

memory is the storage space in computer where data is to be processed and instructions 

required for processing are stored. The memory is divided into large number of small 

parts called cells. Each location or cell has a unique address which varies from zero to 

memory size minus one. For example if computer has 64k words, then this memory unit 

has 64 * 1024=65536 memory locations. The address of these locations varies from 0 to 

65535. 

Memory is primarily of three types 

 Cache Memory 

 Primary Memory/Main Memory 

 Secondary Memory 

Cache Memory 

Cache memory is a very high speed semiconductor memory which can speed up CPU. It 

acts as a buffer between the CPU and main memory. It is used to hold those parts of data 

and program which are most frequently used by CPU. The parts of data and programs are 

transferred from disk to cache memory by operating system, from where CPU can access 

them. 

Advantages 

The advantages of cache memory are as follows: 

 Cache memory is faster than main memory. 

 It consumes less access time as compared to main memory. 

 It stores the program that can be executed within a short period of time. 

 It stores data for temporary use. 
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Disadvantages 

The disadvantages of cache memory are as follows: 

 Cache memory has limited capacity. 

 It is very expensive. 

Primary Memory (Main Memory) 

Primary memory also called as main memory holds only those data and 

instructions on which computer is currently working. It has limited capacity and data is 

lost when power is switched off (i.e. volatile memory). It is generally made up of 

semiconductor device. These memories are not as fast as cache memory. The data and 

instruction required to be processed by the CPU must reside in main memory. It is 

divided into two subcategories RAM (Random Access Memory) and ROM (Read Only 

Memory). 

Characteristics of Main Memory 

 These are semiconductor memories 

 Usually volatile memory i.e. Data is lost in case power is switched off. 

 It is working memory of the computer. 

 Faster than secondary memories. 

 A computer cannot run without primary memory. 

 

Secondary Memory 

This type of memory is also known as external memory or non-volatile. It is 

slower than main memory. These are used for storing data/Information permanently. 

CPU directly does not access these memories instead they are accessed via input-output 

routines. Contents of secondary memories are first transferred to main memory, and then 

CPU can access it.  

Example: Hard disk, CD-ROM, DVD etc. 

Characteristic of Secondary Memory 

 These are magnetic and optical memories 

 It is known as backup memory. 
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 It is non-volatile memory. i.e. Data is permanently stored even if power is 

switched off. 

 It is used for storage of data in a computer. 

 Computer may run without secondary memory. 

 Slower than primary memories. 

GENERATION OF COMPUTER 

 Generation in computer terminology is a change in technology a computer is being 

used. Initially, the generation term was used to distinguish between varying hardware 

technologies. But nowadays, generation includes both hardware and software, which 

together make up an entire computer system. 

Following are the main five generations of computers: 

S.No. Generation Period Technology Used 

1 First Generation 1946-1959 Vacuum tube based. 

2 Second Generation 1959-1965 Transistor based. 

3 Third Generation 1965-1971. Integrated Circuit based. 

4 Fourth Generation  1971-1980  VLSI microprocessor 

based. 

5 Fifth Generation 1980-onwards  ULSI microprocessor 

based 

First Generation 

The period of first generation was 1946-1959. The computers of first generation used 

vacuum tubes as the basic components for memory and circuitry for CPU (Central 

Processing Unit). These tubes, like electric bulbs, produced a lot of heat and were prone 

to frequent fusing of the installations, therefore, were very expensive and could be 

afforded only by very large organizations. In this generation mainly batch processing 

operating system were used. Punched cards, paper tape, and magnetic tape were used as 
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input and output devices. The computers in this generation used machine code as 

programming language. 

The main features of first generation are: 

 Vacuum tube technology 

 Unreliable 

 Supported machine language only 

 Very costly 

 Generated lot of heat 

 Slow input and output devices 

 Huge size 

 Need of A.C. 

 Non-portable 

 Consumed lot of electricity 

Some computers of this generation were: 

 ENIAC 

 EDVAC 

 UNIVAC 

 IBM-701 

 IBM-650 

Second Generation 

The period of second generation was 1959-1965. In this generation transistors were used 

that were cheaper, consumed less power, more compact in size, more reliable and faster 

than the first generation machines made of vacuum tubes. In this generation, magnetic 

cores were used as primary memory and magnetic tape and magnetic disks as secondary 

storage devices. In this generation assembly language and high-level programming 

languages like FORTRAN, COBOL was used. The computers used batch processing and 

multiprogramming operating system. 

 

The main features of second generation are: 
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 Use of transistors 

 Reliable compared to first generation computers 

 Smaller size as compared to first generation computers 

 Generated less heat as compared to first generation computers 

 Consumed less electricity as compared to first generation computers 

 Faster than first generation computers 

 Still very costly 

 A.C. needed 

 Supported machine and assembly languages 

Some computers of this generation were: 

 IBM 1620 

 IBM 7094 

 CDC 1604 

 CDC 3600 

 UNIVAC 1108 

Third Generation 

The period of third generation was 1965-1971. The third generation of computer is 

marked by the use of Integrated Circuits (IC's) in place of transistors. A single IC has 

many transistors, resistors and capacitors along with the associated circuitry. The IC was 

invented by Jack Kilby. This development made computers smaller in size, reliable and 

efficient. 

 In this generation, Remote processing, Time-sharing, Real-time, Multi-

programming Operating System were used. 

High-level language (FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, 

ALGOL-68, etc.) were used during this generation. 

The main features of Third Generation are: 

• IC used 

• More reliable 

• Smaller size 

• Generate less heat 

• Faster 

• Lesser maintenance 
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• Still costly 

• A.C. needed 

• Consumed lesser electricity 

• Support high-level language 

Some computers of this generation were: 

• IBM-360 series 

• Honeywell-6000 series 

• PDP(Personal Data Processor) 

• IBM-370/168 

• TDC-316 

Fourth generation 

The period of fourth generation was 1971-1980. The computers of fourth 

generation used Very Large Scale Integrated (VLSI) circuits. VLSI circuits having about 

5000 transistors and other circuit elements and their associated circuits on a single chip 

made it possible to have microcomputers of fourth generation. Fourth generation 

computers became more powerful, compact, reliable, and affordable. As a result, it gave 

rise to personal computer (PC) revolution. In this generation time sharing, real time, 

networks, distributed operating system were used. All the high-level languages like C, 

C++, DBASE etc., were used in this generation. 

The main features of fourth generation are: 

 VLSI technology used 

 Very cheap 

 Portable and reliable 

 Use of PC's 

 Very small size 

 Pipeline processing 

 No A.C. needed 

 Concept of internet was introduced 

 Great developments in the fields of networks 

 Computers became easily available 

Some computers of this generation were: 

 DEC 10 

 STAR 1000 
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 PDP 11 

 CRAY-1(Super Computer) 

 CRAY-X-MP(Super Computer) 

Fifth generation 

The period of fifth generation is 1980-till date. In the fifth generation, the VLSI 

technology became ULSI (Ultra Large Scale Integration) technology, resulting in the 

production of microprocessor chips having ten million electronic components. This 

generation is based on parallel processing hardware and AI (Artificial Intelligence) 

software. AI is an emerging branch in computer science, which interprets means and 

method of making computers think like human beings. All the high-level languages like 

C and C++, Java, .Net etc., are used in this generation. 

AI includes: 

 Robotics 

 Neural Networks 

 Game Playing 

 Development of expert systems to make decisions in real life situations. 

 Natural language understanding and generation. 

The main features of Fifth Generation are: 

• ULSI technology 

• Development of true artificial intelligence 

• Development of Natural language processing 

• Advancement in Parallel Processing 

• Advancement in Superconductor technology 

• More user friendly interfaces with multimedia features 

• Availability of very powerful and compact computers at cheaper rates 

 

Some computers types of this generation are: 

• Desktop 

• Laptop 

• Note Book 

• Ultra Book 

• Chrome Book 
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COMPUTER LANGUAGES 

Languages are a means of communication. Normally people interact with each 

other through a language. On the same pattern, communication with computers is carried 

out through a language. This language is understood both by user and the machine. Just 

as every language like English, Hindi has its grammatical rules; every computer language 

is bound by rules known as SYNTAX of that language. The user is bound by that syntax 

while communicating with the computer system. 

Computer languages are broadly classified as: 

1. Low Level Language: 

The term low level means closeness to the way in which machine understand. The 

low level languages are: 

a. Machine Language: 

This is the language (in the form of 0‘s and 1‘s, called binary numbers) understood 

directly by the computer. It is machine dependent. It is difficult to learn and even more 

difficult to write programs. 

b. Assembly Language: 

This is the language where the machine codes comprising of 0‘s and 1‘s are 

substituted by symbolic codes (called mnemonics) to improve their understanding. It is 

the first step to improve programming structure. Assembly language programming is 

simpler and less time consuming than machine level programming, it is easier to locate 

and correct errors in assembly language than in machine language programs. It is also 

machine dependent. Programmers must have knowledge of the machine on which the 

program will run. 

2. High Level Language 

Low level language requires extensive knowledge of the hardware since it is 

machine dependent. To overcome the limitation, high level language has been evolved 

which uses normal English like, easy to understand statements to solve any problem. 

Higher level languages are computer independent and programming becomes quite easy 

and simple. 

Various high level languages are given below: 
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BASIC (Beginners All Purpose Symbolic Instruction Code): It is widely used, easy to 

learn general purpose language which is mainly used in microcomputers in earlier days. 

COBOL (Common Business Oriented language): A standardized language used for 

commercial applications. 

FORTRAN (Formula Translation): Developed for solving mathematical and scientific 

problems and its one of the most popular languages among scientific community. 

 C: Structured Programming Language used for all purpose such as scientific application, 

commercial application, developing games etc. 

C++: Popular object oriented programming language, used for general purpose. 
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Unit II - Personal Computers in Business 

The computer plays many roles in business, including communications, data 

storage and data analysis. It reduces businesses cost by making employees more efficient 

and providing tools that would cost too much without a computer. Computers can analyze 

huge data sets and find out new information that can help with business decisions. 

Finally, the computer makes some things possible that would have been difficult in the 

past. Businesses uses different types of computers such as desktops, laptops, servers, 

smart phones and tablets, depending on their needs. With computers, employees are able 

to work anytime, anywhere. 

Computers in Business 

Computers in recent times are being used in diversified fields such as business and 

industry, services, engineering, health care, education, etc. A computer can be applied in 

almost all types of accounting, technical and managerial matters of business and industry. 

Some of the areas where computers are used in business and industry are as follows: 

[a] Inventory Control, 

[b] Production Planning, 

[c] Budgeting and Variance Analysis, 

[d] Plant Capacity Utilization, 

[e] Quality Control, 

[f] Marketing Research, 

[g] Purchase Accounting, 

[h] Sales Accounting, 

[i] Payroll Accounting, 

j] Information Management, and so. 
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PC SOFTWARE PACKAGES: INTRODUCTION 

Software is an essential part of a computer system. Two types of software are 

application software and system software. Application software consists of programs that 

perform specific tasks for users, such as a word processing program, e-mail program, or 

Web browser. System software consists of the programs that control the operations of a 

computer and its devices. The two types of system software are operating systems and 

utility programs. An operating system (OS) is a set of programs containing instructions 

that coordinate all the activities among computer hardware devices. A utility 

program performs a specific task, usually related to managing a computer, its devices, or 

its programs. This chapter defines Operating System software 

User interface 

A user interface controls how a user enters data and instructions and how 

information displays on the screen. Two types of user interfaces are command-line and 

graphical. With a command-line interface, you type keywords or press special keys to 

enter data or instructions. A graphical user interface (GUI) allows you to use menus 

and visual images such as icons, buttons, and other graphical objects to issue commands. 

A menu is a set of commands from which you can choose. An icon is a small image that 

represents a program, an instruction, a file, or some other object. 

Operating System 

An Operating System (OS) is a system software which acts an interface between the user, 

the hardware the software and the application programs. Operating system performs all 

the basic tasks like file management, memory management, process management, 

handling input and output, and controlling peripheral devices such as disk drives and 

printers. 

Some popular Operating Systems include DOS, Linux, Windows, OS X, VMS, OS/400, 

AIX, z/OS, etc. 

DISK OPERATING SYSTEM (DOS) 

An Operating System (OS) is an integrated set of specialized programs that is used to 

control and manage the resources and overall operation of a computer system. It is a class 

of software, which controls the execution of other programs. 
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DOS is the most commonly used operating system. The full form of DOS is Disk 

Operating System. It is a single user operating system which means that only one 

application can be made to run at one time. DOS provides a 'Platform' or an 

'Environment' which lets the application program to interact with CPU and I/O devices. 

Much application software requires DOS for running. The common among these are 

word processors like Word Star, Professional write; spreadsheet programs like Lotus 123, 

VP Planner Plus; accounting software like Tally, EX, etc. 

Each software package has a specific command to get it running on DOS. For 

example, in order to run the spreadsheet program, Lotus 123, you will have to enter 123 

at the DOS prompt, DOS will run Lotus 123.  

MS DOS (Microsoft Disk Operating System), a product of Microsoft Corporation of 

USA, is the most popular operating system for PCs. Another operating system available 

in the market is the PC DOS, a product of IBM, which is almost similar to MS DOS. 

Whether you use MS DOS or PC DOS, the basic commands of DOS remains the same. 

MS-DOS Operating System 

MS-DOS is a text-based operating system.  In contrast to Windows, which has a 

graphical user interface, and uses the mouse and icons to send commands to the system, 

DOS commands are entered at the command line in text format. 

MS-DOS uses a hierarchical organization of directories to store its files. The term 

hierarchical means that the directories and files are organized in the shape of a tree (root 

at the top).  Each row is linked to the objects (files and folders) directly beneath it.  The 

hierarchical organization allows for directories to be created within directories thus 

making a directory tree. The root directory is the highest possible level on the directory 

hierarchy on a given drive. The parent-directory is the name for any directory above a 

subdirectory.   
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Files are anything that contains data. Word processing documents, spreadsheets, saved  

e-mail messages are all examples of files. A directory is a place where files are collected.  

 

Pathname 

We can refer to any file in any directory on the system by using its pathname. A 

pathname is a string of characters that describes what directory the file is in, as well as 

the name of the file. The full path always starts from the ROOT directory.  The ROOT 

directory is the top directory in a file system. 

The pathname of a file in the current working directory is just the file name.  

Files and directories that are in a different directory can be referred to using: 

An absolute pathname describes another directory in a way that does not depend 

on where you are. The absolute pathname is always the same, regardless of your working 

directory. 

A relative pathname describes another other file or directory's location relative to 

the current working directory.   The relative path changes depending on where you are in 

the directory tree. 

 

Loading DOS 

In the earlier days booting happens automatically when the computer is switched 

on, provided DOS is available in it. DOS can be present on both hard disk as well as the 

floppy disk. So, when the system is turned on, a search for DOS is done on floppy drive 
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first. If it is not present on the floppy drive, the DOS is searched for on the hard disk. 

Thus, for booting to happen, the DOS must be present either on the floppy or on the hard 

disk. So, if DOS is not present on the hard disk, insert the floppy carrying DOS software 

in the A drive before switching on the system. If the system boots from floppy, the 

following prompt comes on the screen: 

A:\> 

where underscore character '- ' indicates the cursor (blinking mark) of the screen. 

However, if booting has been done from the hard disk, then the following prompt will 

come: 

C:\> 

C:\> or A:\> is the DOS Prompt. Looking at DOS Prompt, you can easily make out the 

currently active drive. If you want to switch yourself over to the another drive, then 

simply type its drive letter after the prompt and hit the <Enter> key as shown below: 

C:\>A: <Enter> 

A:\> 

Now again if you want to go back to the C drive, then type in C: and hit the <Enter> key. 

The earliest versions of the Microsoft Windows operating system were really just 

applications that ran on top of the MS-DOS operating system.  

Now-a-days modern versions of Windows (Windows 95 and greater) no longer 

run on top of DOS, but do retain a DOS-like user interface called the "MS-DOS Prompt" 

or "Command Prompt". The command prompt allows Windows users to issue DOS 

commands to the system. 

DOS commands are useful to Windows users for a variety of reasons. Many tasks 

that can be performed in the Windows graphical environment can be performed much 

more quickly and efficiently by utilizing DOS commands.  

Loading DOS through Windows 

Users of any Windows system can invoke a command prompt by performing the 

following steps: 

1. Click Start. 

2. Select Run. 
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3. In the "Open:" field, type command. 

4. Click OK. 

A command prompt window is generally white or gray text on a black background. The 

prompt itself usually takes the following form: 

X:\PATH> 

where "X" represents the letter of the active drive, and "PATH" refers to the present 

working directory. Here's an example of how a DOS command prompt commonly looks: 

C:\Windows>_ 

 
Figure 1 Loading DOS through Windows 

 File Naming Conventions 

There are certain rules that have to be followed while giving names to the files. A file 

name has two parts Primary Name and Extension. A dot (.) separates a primary name 

from an extension. Let us see the two parts of the file named STUDENT.TXT. 

 

STUDENT.TXT 

       |         | 

Primary    Extension 

Name 
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A primary name cannot have more than eight characters and an extension cannot have 

more than three characters. A file name having only the primary name and no extension 

is absolutely valid because it is optional to give an extension to a file name. An extension 

is generally given by the language or software used. For example, if you are entering a 

BASIC or PASCAL program, its file name would have extension BAS or PAS 

respectively. A file name can contain the following characters: 

1. An Alphabet (A-Z) or (a-z) 

2. A number (0-9) 

3. Special characters such as: $, #, &, @, !, %, (, ), -, { , }, " A, etc. Except *, ?, full stop 

(.) and space ( ). 

4. File name must start with an alphabet. 

It is a good practice to give meaningful names to the files. However, no two files 

can have exactly the same name on the disk. Thus, a name given to a file on a disk has to 

be unique. 

A look at a few valid and invalid file names: 

VALID INVALID 

NAME_LIST MY  BOOK.DOC 

Dragon.Txt B.R.Arora 

Mark.xls S?JAIN.BAS 

VIJAYA 2EXCEL 

Employee.Emp ANARAG.** 

 

DOS Commands 

DOS offers a variety of commands to perform various functions. With the help of 

DOS commands, we can display the list of files and directories that are present on the 

disk, create new files and directories, remove unwanted files and directories and much 

more. DOS commands can be entered either in uppercase or lowercase letters. The format 

of a DOS command is called syntax. All DOS commands begin with command name. 

When DOS carries out the instructions given by us, it is called the execution of DOS 

command. Let us discuss some of the DOS commands in detail. (The commands which 

you should issue are written as bold letters throughout this unit). 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

39 

 

1. Displaying a List of Files on the Disk: DIR command 

This DOS command displays the list of files or directories that are present on hard 

disk as well as floppy disk. Thus, to see the contents of your hard disk, issue the 

following command: 

C\>DIR <Enter> 

 

The above command displays the primary name, extension and size of files in bytes. It 

also displays the date and time when the file was created or modified last. If you wish to 

view the contents of the floppy drive, then you first switch yourself to the floppy drive 

and then issue the DIR command as shown below: 

C\> A: <Enter> 

A:\>DIR <Enter> 

 

If you wish to view the contents of the sub-directory EXPENSE (Ref Fig), then issue the 

following command: 

C\>DIR \EXPENSE <Enter> 

Let us assume that there is one more sub-directory by the name BUSINESS 

existing under EXPENSE. To view the contents of this sub-directory, issue the following 

command: 

C:\>DIR \EXPENSE\BUSINESS <Enter> 

If you have a large number of files on the disk, then on issuing, DIR command, the screen 

scrolls up and only a few file names are shown. In such a case, issue the following 

command: 

C:\>DIR/P <Enter> 
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The above command will show the contents of the disk page wise or screen wise. Now, if 

you are interested only in seeing the file names, then issue the following command: 

C:\>DIR/W <Enter> 

The above command shows the names of files and directories widthwise. So, in one line 

only five names of files and directories are shown. The other details like the size of file, 

the date and time of each file creation are not shown. The directories are shown in square 

([]) brackets. 

2. Making a Directory: MD Command 

We can create any directory under any directory in the hard disk or floppy disk. 

The command to create a new directory is MKDIR or MD.  

Let us create a new sub-directory by the name INCOME under the Root directory. 

The following command can achieve this: 

C:\>MD INCOME <Enter> 

where MD stands for Make Directory. Further, let us create another sub-directory by the 

name HOSPITAL under the sub-directory Income. 

C:\>MKDIR INCOME\HOSPITAL <Enter> 

3. Removing a Directory: RD command 

With time, certain directories grow old and are no more needed. It is better to 

delete such directories because they can save us many precious bytes on the disk. So, let 

us delete the sub-directory HOSPITAL with the following command: 

C:\>RD INCOME\HOSPITAL <Enter> 

where RD stands for Remove Directory 

A directory or a sub-directory has to be essentially empty before removing it. For 

example, in order to remove the sub-directory HOSPITAL, there should not be any 

directories and files under it. So, you must first delete all the files and remove all the sub-

directories present under the subdirectory HOSPITAL before removing it.  
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4. Changing Directory: CD command 

Let us again refer to the Figure. Suppose you are under the EXPENSE sub-

directory and you want to access the files or directories in the ACCOUNT sub-directory. 

This would involve the changing of directory from EXPENSE to ACCOUNT. This will 

make the ACCOUNT directory active. The task of changing directories can be 

accomplished with the help of CD command. 

Look at the following example: 

C:\>CD ACCOUNT <Enter> 

where CD stands for Change Directory 

The above command will take you to the sub-directory ACCOUNT as shown by the 

following prompt: 

C: \ACCOUNT> 

If you want to go to the sub-directory CASHSALE straight from the sub-directory 

EXPENSE, issue the following command: 

C:\>CD ACCOUNT\CASHSALE <Enter> 

After the above command, the following prompt will come: 

C:\ACCOUNT\CASHSALE> 

The command for going to the root directory from the above prompt is: 

C:\ACCOUNT\CASHSALE>CD\ <Enter> 

But, the command for going to the parent or previous directory (whether it is root or sub-

directory) is: 

C: \ACCOUNT\ CASHSALE>CD.. <Enter> 

If you are in the sub-directory CASHSALE, the above command will take you to 

ACCOUNT subdirectory as shown below: 

C: \ACCOUNT> 

File Commands of DOS 
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DOS offers a number of file commands for performing various operations on your file 

like copying, deleting and renaming the files. 

1. Copying Files: The COPY Command 

At times, you may have to work on some other machine. So, this involves copying 

files from one disk to another. Copying of files can happen from hard disk to floppy or 

vice-versa. Files can also be copied onto the same disk with a different name. The COPY 

command helps us to accomplish all these tasks. 

The syntax of the copy command is: 

COPY <Source drive>: (File spec 1) <Target drive>: (File spec 2) 

where Source drive refers to the drive from where the file has to be copied. It can be 

A, B or C. 'File Spec l' refers to the path from where the file that has to be copied. 'Target 

drive' refers to the drive where the file is going to be copied. 'File Spec 2' refers to the 

destination where the file is going to be copied. 

(i) Copying a file to another drive under the same name: A file can have the same 

name if it is stored on different disks. Thus, to copy a file by the name SCENE from hard 

disk to floppy disk, issue the following command: 

C: \> COPY C:SCENE A:SCENE <Enter> 

As the file is copied from the active drive, then there is no need to specify the source 

drive in the above command. On similar grounds, if the file name remains unchanged 

then there is no need specify it after the target drive. Thus, the above command can also 

be given in the following way: 

C:\>COPY SCENE A: <Enter> 

(ii) Copying a file to another disk under a different name: The name of the file can be 

changed very easily while copying. The following command copies the file SCENE from 

the hard disk onto floppy disk by the name SERENE. 

C: \>COPY SCENE A:SERENE <Enter> 
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(iii) Copying a file with a new name on the same disk: The file can be copied with a 

different name and stored on the same disk. Proceeding with the above example, let us 

save the file SCENE with a new name, SERENE and copy it onto the same disk. 

C:\>COPY SCENE SERENE <Enter> 

Once this command is executed, we have the same file under two different names, stored 

on the same disk. 

(iv) Copying files from one directory to another: Suppose you have placed all your 

files under the root directory. Now, at later point of time, you wish to club all the related 

files at one place. This can be easily done. Create a directory and copy the required files 

from the root directory to this newly created directory. DOS allows you to copy files 

from one directory to another. 

Let us assume that you have a file by the name NORTH.TXT in the root directory and 

you wish to copy this file in the newly created Area sub-directory. The following 

command will do this: 

C:\>COPY NORTH.TXT \AREA <Enter> 

Similarly, you can copy files from any directory to any other directory. DOS only needs 

the specification of full path from you. Let us copy a file OLD.TXT which exists under 

the subdirectory DATA to the sub-directory INFO which is resident in the floppy disk. 

C:\>COPY DATA\OLD.TXT A:\INFO <Enter> 

2. Deleting Files: DEL Command 

With time, certain files grow old which are no longer required. So, it is desirable to delete 

such files because unwanted files occupy precious space on the disk. Suppose there is a 

file on the hard disk by the name TRYPRG which is no longer required. The following 

command deletes this file: 

C:\> DEL TRYPRG <Enter> 

If the file SALE.PRG exists on the floppy disk, first you go to the A: prompt and then 

delete the file as shown below: 

C:\>A: <Enter> 
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A:\>DEL TRYPRG <Enter> 

While deleting any file of a sub-directory, its full path should be given as illustrated in 

the following example. Let us assume that the TRY.PRG file exists under a subdirectory 

MANAGE on the hard disk. To delete this file-issue one of the following commands: 

C:\>DEL C:\MANAGE\TRYPRG <Enter> 

OR 

C:\>DEL MANAGE\TRYPRG <Enter> 

You can also delete the TRYPRG file by first changing to that sub-directory and then 

issuing the DEL command as given below: 

C:\>CD\MANAGE <Enter>  

C:\MANAGE>DEL TRY.PRG <Enter> 

3. Renaming Files: REN Command 

DOS allows you to give new names to your files. Assume that there is a file by the name 

OLD.TXT and now you wish to give a new name NEW.TXT to it. Carry out one of the 

following commands. 

C:\>REN OLD.TXT NEW.TXT <Enter> 

or 

C:\>REN DATA\OLD.TXT NEW.TXT <Enter> 

The file OLD.TXT which resides under the sub-directory DATA now has a new name 
NEW.TXT. 

Wildcards 

Often you may need to do a similar kind of job on a number of files. If these files 

have something in common, then we can save the effort of performing repetitive job. So, 

these files can be referred collectively by using the wildcard facility provided by DOS. 

The use of wildcards in a DOS command gives greater flexibility when using similar type 

of file names. DOS offers two wildcards ‗?‘ and ‗*‘. Each ‗?‘ can be replaced by exactly 

one character or none, if it is given at the end of the filename. As and when the ‗?‘ 
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wildcard is specified in the middle of a filename, it has to necessarily match one 

character. The ‗*‘ wildcard can match eight or less characters in the primary name and 

three or less characters in the extension part. 

Let us take an example to make the concept of wildcards clear. Suppose the 

following files are present onto your disk: 

Old.Txt   INCOME.pro  Alpha   Page.in 

Go.Exe   OLDl    Dragon.Exe   KOMAL 

Expense.prg    OLD20.bas   Over.prg  Annual. doc 

New. doc   Zee.com   Old.doc  Paper. com 

The following commands illustrate the concept of wildcards: 

(i) If you wish to see all the files that start with the letter O and any extension, then give 

the following command: 

C:\>DIR O*.* <Enter> 

The above command will list the files OLD.TXT, OLDl, OVER.PRG, OLD20 and 

OLD.DOC 

(ii) Now, let us copy all the files with any number of characters in the primary name and 

the extension EXE with the following command. 

C:\>COPY *.EXE A: <Enter> 

The above command will copy the files GO.EXE and DRAGON.EXE onto the floppy 

disk. 

(iii) To delete all the files beginning with OL, having two more characters in the primary 

name and any extension, issue the following command. 

C:\>DEL OL??* <Enter> 

With this command, the files OLD.TXT, OLD.DOC and OLDl are going to be deleted 

because these are the only files present on the disk which match the given wildcard 

pattern. The above command will not delete the files OVER.PRG and OLD20, because 

the former does not start with OL and the latter has 5 characters primary name. 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

46 

 

(iv) Similarly, to delete all files starting with P and an extension comprising of two 

characters ending with N issue the following command: 

C:\>DEL P*.?N <Enter> 

This will delete the file PAGE.IN because this is the only file matching the given 

wildcard pattern. 

(v) For copying all the files having primary name OLD and any extension from floppy to 

EXPENSE sub-directory of hard disk, issue the following command: 

A:\>COPY OLD.* C:\EXPENSE <Enter> 

The above command will copy only two files OLD.DOC and OLD.TXT. 

(vi) To copy all the files with primary name anything and no extension from EXPENSE 

subdirectory of hard disk to floppy, issue the following command: 

C:\>COPY \EXPENSE\*. A: <Enter> 

The above command will copy the files ALPHA, OLDl and KOMAL. 

(vii) To delete all the files of floppy, issue the following command: 

A:\>DEL *.* <Enter> 

After giving the above command, the following message will come on the screen: 

Are you Sure (Y /N)? _ 

Press 'Y' if you really want to delete all files otherwise press any key. Never try the above 

command on root directory of hard disk, otherwise your most important DOS file 

COMMAND.COM will also be deleted and thereafter you will not be able to boot the 

system from the hard disk. Therefore, wildcards with DEL command should be used with 

great caution. 

Some More DOS Commands 

You have already been introduced to the directory and file commands of DOS. Now, let 

us make ourselves familiar with other commonly used commands. 
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(A) Displaying and/or changing date: The DATE Command 

DOS allows you to show as well as change the current date once you are on the DOS 

prompt. 

Issue the following command to see or change the today's date: 

C:\>DATE <Enter> 

After issuing the above command the following screen appears: 

Current date is Thu 11-16-Enter new date (mm-dd-yy):_ 

So, key in the new date in 'month-date-year' format. However if you do not want to 

change this date simply hit the <Enter> key. The current date will be taken as new date. 

(B) Displaying and/or changing the current time: The TIME 

Command 

The TIME command is used to display and change the current time. 

C: \> TIME <Enter> 

 

On issuing this command, the following screen appears: 

Current time is 11:05:10:01 

Enter new time: 

Enter the new time in hours: minutes: seconds format. Hit the <Enter> key if you do not 

want to change the time. The new time can also be specified along with TIME command. 

(C) Clearing screen: The CLS Command 

In order to clear the cluttered and clumsy screen, issue the CLS command. This will 

remove the contents shown on your screen thus making it look neater and cleaner. The 

CLS command is given in the following manner. 

C:\>CLS <Enter> 
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WINDOWS  

Windows is a popular user friendly operating system. It‘s a product of Microsoft. 

It is a Graphical User Interface (GUI) which has been designed to make your work more 

intuitive and easy. There is no more need of remembering the syntax of commands to get 

your work done. Everything is provided in the form of pictures and graphics. The 

program files and other resources are generally accessed with the help of mouse. The 

windows desktop acts as the primary media for organizing the programs, files and 

resources. 

Features of Windows 

We will briefly discuss some of the features of Windows: 

1. It provides a graphical operating environment. All the programs and other resources 

are provided in the form of Icons. 

2. It is a full fledged operating system with an in-built copy of DOS. DOS programs can 

be safely run on Windows. 

3. It is a multi-threaded and preemptive multi-tasking operating system which means that 

more than one application can be made to run simultaneously and more smoothly. 

4. It supports long file names upto 255 characters, thus, breaking the DOS naming 

convention where you can give primary file name upto 8 characters. 

5. The plug and play feature of Windows automatically adapts itself to the hardware it is 

running on. It can detect hardware and then install all the proper drivers automatically 

6. Files can be easily organized in the folders and can be quickly accessed by mouse 

clicks.  

The Windows Desktop 

So, as and when you switch on your computer, Windows is loaded. The Desktop 

is the very first screen you seen after Windows start. In the desktop we can see the icons 

such as My Computer, Recycle Bin, Start Button, Taskbar, and shortcuts to applications.  
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The active application window will appear in the desktop and its name will be shown in taskbar.  

My Computer  

The "My Computer" icon on the desktops opens a view into the resources of the 

local computer. The contents of the ‗My computer‘ Window depend on the disk drives on 

your PC and the network support that is installed. 

When you double-click on the My Computer icon on the desktop, it will open a 

window similar to the one shown below, where you can navigate between the computer's 

drives and Control Panel tools. 
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Recycle Bin  

When you delete a file from your computer's hard drive, it is removed 

from the place where you delete to a special folder called Recycle Bin. Files 

deleted from your hard drive will still be available for restoring if needed, 

unless you empty your Recycle Bin.   

 To restore the files, open the Recycle 

Bin folder by double-clicking the icon 

on your desktop, select the file and 

then select Restore. 

    
 To clear the Recycle Bin, select 

Empty Recycle Bin and the files will 

be permanently removed from your 

computer.  

Note that the recycle bin does not apply to the 

contents of a floppy disk. If you delete a file 

from a floppy disk, it is permanently deleted, 

and you cannot restore it. 
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Active Window 

The window is the portion of the screen that shows you the application that you have 

opened. These buttons are in the upper right-hand corner of almost every window:      

, either  or , and  

MAXIMIZE  enlarges the window to fill the whole screen. 

RESTORE  takes a maximized window back down to its smaller size. 

MINIMIZE  sends the window to the TASKBAR, where it becomes an inactive button.  

CLOSE BOX  closes the window. 

RESIZE a window: Grab an edge of the window frame with the cursor, and drag the 

edge to make the window larger or smaller.  (To grab, put the cursor on the edge and hold 

down the left mouse button. To drag, keep holding the button and move the mouse). 

Active/ Inactive:  

The window where the present operation is taking place is the ACTIVE 

WINDOW. All other opened windows are INACTIVE. The active window is always on 

top. The title bar of the active window will be a different color from all the other title 

bars. On the Taskbar, the gray button for the active window looks pushed in, or darker 

blue 

Start Menu  

By clicking the Start button, in the very bottom-left corner 

of the screen, a vertical window will come up with the Start 

Menu. The list of submenus in the pop-up window let you 

navigate and select the application you want to run. 

1. The Program Menu 

It contains program groups and individual programs. Thus, to 

launch any program, simply take your mouse pointer at that 

particular program and click it. In order to open 'Accessories' 

program group, move the mouse pointer to that group and a 
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cascading menu will appear on the screen. It contains Windows accessory programs such 

as WordPad, Paint, Notepad, etc. 

2. The Document Menu 

This menu shows you the document that you recently opened or worked upon. 

This offers a short way of opening a document. It launches the application in which the 

document was created. The document menu keeps tracks of the latest fifteen documents 

that you have used and it puts them in an alphabetical order. 

3. The Settings Menu 

This menu is used for changing the default system setting. You can access the 

control panel, printer folder and taskbar setting from here. 

4. The Find Command 

The Find option of the start menu helps in locating a particular file or a folder. It 

offers a quick way of finding files. In the 'Named' box type in the file name you want to 

search. Accordingly, Windows will show the full details about the file if present. 

5. The Help Command 

Windows has got very smart help features. In case you find yourself stuck on any 

issue simply select the Help option from the Start Menu. Above all, you can type in your 

query in your own words. Windows will display you the related information. 

6. The Run Command 

The Run option of the Start Menu helps you to run your file or application 

straightway. To open any application program, just type the exe file name of the 

application. To open files, type the full path and the filename in the 'Open' box and click 

at 'OK' button. You can also make use of the 'Browse' button in order to locate 

appropriate files.  

7. The Shutdown Command 

This command is used for shutting down the system. It offers three options. You 

can shut down your system, restart your system in windows mode itself or you can switch 
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yourself to DOS mode temporarily. Select appropriate option depending upon your 

requirement. 

 

Taskbar  

The Taskbar is the row at the bottom of the Windows screen where all currently open 

applications or files are listed. The taskbar is used to select a file or application that is 

already opened or to put an application in the foreground. To put an application in the 

foreground, just click on the icon of the application in the taskbar. Another way to put an 

application in the foreground when more than one is in use is to hold the ALT button and 

then press TAB on your keyboard. To see all the open applications you have to hold the 

ALT button and continue pressing TAB to go through each application until you come to 

the one you want to use. 

 

Shortcut  

A shortcut creates a button or icon which typically stays on the 

desktop and when clicked, quickly allows you to start a program or 

open a file without having to go to its permanent location on your 

computer.  

To create a shortcut, open the 

Windows Explorer or go to the Start 

menu, select the file or program you want 

to create a shortcut for, place the cursor on 

the icon for the file, then right-click and 

select Create Shortcut from the menu that 

pops up. The shortcut file will be created. 

After that, you drag the shortcut file to the 

desktop and whenever you click on it, it 

will open the application or document 

related to the shortcut. 
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Shortcut Keys 

  Shortcut keys help provide an easier and faster method of navigating through the 

Windows operating system.  The shortcuts are commonly accessible by using Alt, Ctrl 

and/or Shift in conjunction with a single letter. 

 a) The following list of shortcuts is useful in word processing programs like Word, 

Notepad or Word pad:  (Del = Delete; Ins = Insert) 

 Alt + F  Brings up file menu options 

 Alt + E  Brings up edit menu options 

 F1   Brings up help window (also works on the desktop) 

 Ctrl + A  Select all text 

 Ctrl + X   Cut selected text 

 Shift + Del  Cut selected text 

 Ctrl + C  Copy selected text 

 Ctrl + Ins  Copy selected text 

 Ctrl + V  Paste   

 Shift + Ins  Paste 

 Home   Goes to beginning of current line 

 Ctrl + Home  Goes to beginning of document 

 End   Goes to end of current line 

 Ctrl + End  Goes to end of document 

 Shift + Home Highlights the current position to beginning of line 

 Shift + End  Highlights the current position to end of line 

 Ctrl + left arrow Moves one word to left 

 Ctrl + right arrow Moves one word to right 

b)  The following list of shortcuts is used on the desktop: 

 Alt + Tab  Switch between open applications 

 Alt + Shift + Tab Switch backwards between open applications 

 Print Screen  Create a screen shot of entire desktop 

 Alt + Print Screen Create a screen shot only for current program 

 Ctrl + Esc  Bring up Start Menu 
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 Alt + Esc  Switch between open applications on task bar 

 F2   Renames selected icon 

 F3   Brings up Search window from desktop  

 Alt + F4  Closes current open program 

 Ctrl + F4  Closes window in a program 

 Alt + Enter  Opens properties window for selected icon or program 

 Shift + F10  Simulates right click on selected item 

 Shift + Del  Deletes programs/files without putting them in recycle bin 

 

 The Tab key is a very useful shortcut key.  On the desktop, pressing tab will allow 

you cycle between: 

 i) The Start Button – press enter to bring up the start menu 

 ii) Windows tabs -  use arrow keys to traverse open tabs and enter key to launch 

 iii) System tray – use arrow keys to traverse icons and enter key to launch  

 iv) Desktop icons – use arrow keys to traverse and enter key to launch 

 As well, you can use Tab on web pages to cycle through text fields, check boxes 

and buttons.  Tab is used to go from top to bottom and Shift + Tab is used to go from 

bottom to top. 

Multitasking  

Multitasking means working with more than one application at the same time. 

You can be more productive by multitasking. For instance, you can download files from 

the Internet while managing your files or word processing. In order to switch between the 

applications you can use the Taskbar, clicking on the icon of the application you want to 

have in the foreground.  

Right and Left Click  

To use the mouse, usually you click the left button. However you can also right-

click to display a hidden menu related to the object you are in when clicking. This menu 

can vary depending on which application you are using. 

With right-clicking, you can operate different functions such as:  



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

56 

 

 Copy/cut or paste a text, file, or folder.  

 Rename or delete a file or folder.  

Windows Explorer 

The File Manager of Windows OS is called Windows explorer. It helps you to 

manage and organize your files and folders. This screen lets you to explore anything on 

your system. The left part of the explorer screen shows the desktop at the highest level. 

All the components of the desktop like 'My Computer' ,'Network Neighbourhood', 

'Recycle Bin', etc., are shown under it. You must have observed that some components of 

the desktop have a plus sign (+) before them. It shows that there is deeper level of 

components under it. On clicking at the plus sign, the next level of the hierarchy is 

shown. This layering of components continues as long as there is deeper level of folders 

or components underneath. The right side of the Explorer Screen shows the contents of 

the folder or the components that are selected in the left part of the explorer window. In 

the right part of window only, the major actions are performed. Now, we will learn some 

of the important functions that are performed frequently. 
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Figure 2 Windows Explorer 

(A) Renaming a file or a folder 

In order to rename a file or a folder, follow the steps given below: 

1. Select the file or the folder that has to be renamed. 

2. Right click the mouse button and select the Rename option. 

3. Type in the new name that you wish to give to the file. 

(B) Deleting a file or folder 

A file or a folder can be safely deleted by following the steps given below: 

1. Select the file or folder that has to be deleted. 

2. Hit the <Del> key or from the File menu, select the Delete option. 

3. Windows will confirm before deleting the file. 
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(C) Moving a file 

Windows allows you to move files from one place to another. A file can be moved 

from one folder to another by simply performing the following drag and drop procedure: 

1. Select the file that you want to move from the right pane. 

2 Click the file or the folder on the left pane and drag it in the new destination. 

(D) Copying a file to a external storage 

In order to copy a file to the floppy disk, follow the steps mentioned below: 

1. Select the file that has to be copied to the floppy disk. 

2. Right click the mouse button and select the Send To option. 

3. Select the external disk to which the file has to be copied. 

(E) Creating a new folder 

A new folder can be created by following the steps given below: 

1. Select the parent folder that will contain the new folder. 

2. From the File menu, select the New option. From the cascading menu, select the 

Folder option. 

3. Windows will ask you the name that has to be given to the new folder. 
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Unit 3 – Word Processing Software 

WHAT IS WORD-PROCESSING? 

Word processing includes typing text and manipulating it so as to give a very 

systematic and organized look to the document, which enables easy reading. The 

application software or the program which helps us in processing the text is called a 

'Word Processing Software, or simply a 'Word Processor'. 

Word processor enables you to create, edit, print and save documents for future 

retrieval and reference. Creating a document involves typing by using a keyboard and 

saving it. Editing a document involves correcting the spelling mistakes, if any, deleting or 

moving words sentences or paragraphs. 

Advantages of Word Processing 

One of the main advantages of a word processor over a conventional typewriter is 

that a word processor enables you to make changes to a document without retyping the 

entire document. 

Features of Word Processing 

Most Word Processor available today allows more than just creating and editing 

documents. They have wide range of other tools and functions, which are used in 

formatting the documents. The following are the main features of a Word Processor 

i) Text is typed into the computer, which allows alterations to be made easily. 

ii) Words and sentences can be inserted, modified or deleted. 

iii) Paragraphs or text can be copied /moved throughout the document. 

iv) Margins and page length can be adjusted as desired. 

v) Spelling can be checked and modified through the spell check facility. 

vi) Multiple document/files can be merged. 

vii) Multiple copies of letters can be generated with different addresses through the 

mail-merge facility. 
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Uses of Word Processing 

Normally, a word processor can accomplish the following tasks: 

 Brochures 

 Newsletters 

 Reports 

 Advertisement 

 Resumes and Cover letters 

 Books 

 Directories 

 Web Pages 

There is absolutely no end to what a word processor can do.  

There are many software packages to do the job of word processing. Some of them 

work in DOS environment. Examples are WordStar, Word Perfect and Professional 

Write. But in these days working in WINDOWS is becoming more and more popular. So 

let us consider software for word processing which works in WINDOWS. Our choice is 

MS-WORD because it is the most popular software in these days. 

MS-WORD is a part of the bigger package called MS OFFICE, which can do much 

more than word processing. MS OFFICE suit has four main components in it. They are 

MS-WORD (for word processing), MS EXCEL (for spreadsheet), MS ACCESS (for 

database management) and MS POWERPOINT (for presentation purposes). However, 

we will limit ourselves to MS-WORD only in this lesson. 

 IMPORTANT FEATURES OF MS-WORD 

MS-Word not only supports word processing features but also DTP features. Some of 

the important features of MS-Word are listed below: 

i) Using word you can create a document and edit them later, as and when 

required, by adding more text, modifying the existing text, deleting/moving 

some part of it. 

ii) Changing the size of the margins can reformat complete document or part of 

text. 

iii) Font size and type of fonts can also be changed. Page numbers and Header and 

Footer can be included. 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

62 

 

iv) Spelling can be checked and correction can be made automatically in the entire 

document. Word count and other statistics can be generated. 

v) Text can be formatted in columnar style as we see in the newspaper. Text 

boxes can be made. 

vi) Tables can be made and included in the text. 

vii) Word also allows the user to mix the graphical pictures with the text. Graphical 

pictures can either be created in word itself or can be imported from outside 

like from Clip Art Gallery. 

viii) Word also provides the mail-merge facility.   

ix) Word also has the facility of macros. Macros can be either attached to some 

function/special keys or to a tool bar or to a menu. 

x) It also provides online help of any option. 

CREATING DOCUMENT: MS WORD 

STARTING WORD 

To startup Word do the following steps: 

1. Click at the Start button which lies at the bottom left corner of the screen. 

2. Click at the 'Programs' option. A cascading menu appears on the screen. 

3. Click at 'Office' option. Again, a cascading menu appears. Select 'Microsoft Word' 

option of the cascading menu. Word will be loaded in the computer's memory. 

Screen Elements  

When ‗Word‘ opens up, you will notice two windows on the screen, one nested 

closely within the other. The larger among these is called the Application Window, which 

frames the entire screen. The smaller window is called the Document Window, which fits 

in the application window. Both these windows serve a different purpose. The application 

window helps the user to communicate with the Word program, whereas, the document 

window is used for creating and modifying the Word documents. So, as you keep typing, 

the text displayed on the monitor or screen, are actually shown in the document window. 

The different elements of the screen are shown in Figure. The different elements of this 

screen are outlined in Table. 
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Figure 3 Word Screen 

 

Screen 

Element 

Description 

Title Bar  Located at the top of the screen; it displays the name of the application 

(here 'Microsoft Word') and the active document name (here Document l 

'). 

Menu Bar  It shows menu options of Word and is located under title bar.  

Standard 

Toolbar 

Located exactly below the menu bar and gives access to WORD's most 

frequently used commands and utilities. 

Formatting 

Toolbar 

 Lies below the standard toolbar; it offers commonly used formatting 

commands. 

Ruler Bar Located below the formatting toolbar and provides ongoing page 

measurement and quick access to margins, tabs and indents. 

Status Bar  Located at the bottom of the screen; it displays important and varied 

information about the currently opened document like page number, 

column number, line number, etc. 

Scroll Bars Vertical Scroll Bar helps the user to go up or down in the same 

document. Horizontal Scroll Bar helps the user to move in the left or right 

side of the document. 
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Menu Bar 

All the menu pads located on the menu bar can be pulled down by clicking at them 

or by pressing <Alt + key> where 'key' is the underlined character of the menu name. At 

one time only one menu pad can be activated and pulled down. From the pull down list, 

any entry can be selected with the help of mouse. In all the pull down menus, you would 

find that a few entries are shown in light color. These entries are called 'ghosted' entries 

and are inaccessible. These ghosted entries become solid only when the features they 

support become accessible. For example, the cut, copy, paste entries become active from 

the 'Edit' menu only when some text is selected and is made available on the clipboard. 

When the text is no more selected, these entries again become inactive. Now, we will 

explore the contents of different menu pads briefly. 

 File Menu 

 'File' menu can be accessed by pressing either <Alt + F> keys together or by clicking it 

with the help of mouse. This menu is used for performing file 

operations like creating a new file, opening an existing file and 

then closing it. The 'Save' options help to save the files. The 

'Properties' option gives information about the current document. 

The 'Page Setup' option allows setting page size, margins and 

paper orientation etc. Document can be previewed with the 'Print 

Preview' option. The printing operations can be carried out using 

'Print'. 'Exit' option closes the Word application. At the bottom of 

'File' menu, the names of all recently saved files are displayed.  

 

 

Edit Menu 

The 'Edit' menu helps you to delete, copy and move 

chunks of text. The 'Paste Special' option helps you to link your 

text with other applications. 'Find' option tries to help you by 

searching a particular word or phrase. In case you want to 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

65 

 

replace the selected word with some other word or phrase, then use the 'Replace' option. 

The 'Edit' menu  

View Menu 

 The 'View' menu can be used to show your document in a variety of 

ways like Normal, Outline, Page Layout, Master Document and Full 

Screen. Through the 'Toolbars' option, you can also decide the toolbars 

that you want to see on your screen. 'Ruler' option turns on or off the 

ruler line. Headers and footers are added to the document through 

'Header and Footer' option. 

 

 

Insert Menu 
 The 'Insert' menu helps to insert page numbers, the current date 

and  time, symbols, footnotes, cross-references, tables, section-

breaks, files, bookmarks, pictures, objects including equations, 

databases and different varieties of captions. The 'Insert' menu has 

been shown in Figure. 
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Format Menu 
  The 'Format' menu is basically used for enhancing the look 

of the document. It make your document‘s look beautiful by 

adding a variety of font types and sizes, paragraph formats, 

tabs, borders and columns, drop caps, bulleted and 

numbered lists and style settings. The 'Format' menu can 

be seen in Figure. 

 

 

 

 

Tools Menu  

 The 'Tools' menu can be used to check for spelling and 

grammatical errors through the 'Spelling and Grammar' 

option. The 'Word count' option tells you the number of 

words, characters, lines, etc., in the whole document. 

Envelopes and labels can be prepared using 'Envelopes and 

Labels' option. 'Macros' option is used to create and run 

macros. The 'Tools' menu can be seen in Figure 

Table Menu 

 The 'Table' menu adds and edits the tables in your document. A 

row and a column can be safely selected using the 'Select Row' 

and 'Select Column' options respectively. 'Select Table' option 

selects the whole table. The table entries can be sorted using the 

'Sort' option. 'Grid lines' option turns on or off the gridlines of 

the table. The 'Table' menu can be seen in Figure  
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 Window Menu 

The 'Window' menu allows you to add, arrange and select 

document windows in a case where more than one document 

is open.  

Help Menu 

 The 'Help' menu can be used to look for specific 

information. It also gives some knowledge about Microsoft 

Word itself. If you find yourself in a difficult situation 

anytime, then ask help from Word through this particular 

menu. The ‗Help‘ menu has been shown in Figure. 

FILE MANAGEMENT 

It's time to familiarize ourselves with the various important concepts of files like creation 

of new files, opening existing files, saving and finally closing them. 

 

Figure 4 Standard Tool Bar 

Creation of a New Document 

Let us see how to create a new document from scratch. So, for creating a new 

document, click at the 'File' menu and then select the 'New' option as shown in Figure. 

Now, Word is ready to accept text as well as other related commands from you. 

You can also open a new document by clicking at the 'New' button available on the 

standard toolbar. Remember to save your document before quitting. ('Saving a Document' 

is being discussed in the subsequent part). 



 

Manonmaniam Sundaranar University, Directorate of Distance & Continuing Education, Tirunelveli. 

68 

 

 
Figure 5 Creating New File 

Opening a Document 

If a document is stored on any of the storage devices like hard disk or floppy disk, 

then it becomes possible to retrieve that document and manipulate it. Click at the 'File' 

menu and select the option 'Open' option. 

Alternatively, for opening a document, just click at the 'Open' button from the 

standard toolbar.  

When the open option is selected an 'Open' dialog box appears on the screen. In 

this 'Open' dialog box we can notice a 'look in' box which is used for selecting the drive 

as well as the folder where the required document located. 

 

Select the appropriate drive 
here – click on the arrow for 
a list. 

Select the folder here – 
double-click on the 
folder icon to open it. 

Any files in the current folder 
are displayed here. 

Select the file type 
here – click on the 
arrow for a list. 
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Enter your file 

name here. 

Select the 
appropriate drive 
here – click on the 
arrow for a list. 

Select the folder 
here – double-click 
on the folder icon to 
open it. 

Saving a Document  

Once we create a document we must save it for future use. It can be saved on hard disk, 

floppy disk or any other external storage devices. Once all the text is entered, we should 

save the document.  

Click at the 'File' menu 

and then select 'Save' 

option. We will notice a 

screen that looks like 

the following figure. 

 

 

Figure 6 Save As Dialog box 

When the file is being saved for the very first time, the 'Save as' dialog box comes up 

because Word needs some additional information from us. First, Word wants us to give a 

name to our file. This has to be given in the 'Filename 'box. Second, the kind of file 

should be given in the 'Save as type' box. For the word document the default file type is 

‗doc‘. Third, the place where we want to save our document should be given in the 'Save 

in' box. After giving all this information, click at the <Save> button, our file is finally 

saved onto the disk. 

The 'Save as' dialog box is displayed only once until we don't give a name to our 

document. Once the document has a name, next time if we try to save our file after 

making a few changes in it, then the 'Save as' dialog box will not appear on the screen.  

The other way of saving your files is by clicking at the 'Save' button available on 

the standard toolbar or press Ctrl +S in the key board. It's a good idea to keep saving your 

documents after every few minutes. The reason is if the computer goes down or a power 

failure occurs, the unsaved content gets lost. We have to redo the work once again. 
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Closing a Document 

After finishing all the work we must close the all opened file. Otherwise the files 

will reside in the memory and slow down your system. For closing a file, click at the 

'File' menu and select the 'Close' option. 

Word will also prompt you to save your files before closing them as shown in 

Figure. 

 

Figure 7 Promt for Saving the File Before Closing 

If we want the file to be saved before it is closed, then click at <Yes> button otherwise hit 

the <No> button. A case may arise when we want to continue working in the same 

document after issuing 'File Close' command; Select the <Cancel> button. It will allow 

you to work again in the document thus cancelling the issued command. 

Exiting Word 2000 

To quit Word or to close the Word application program, click the ‗Exit‘ option 

from ‗File Menu‘ with this command, all the currently opened documents are also closed 

automatically. 

EDITING 

Editing means modifying or making changes in the document. It involves 

 Inserting new text 
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 Copying text from one part of the document to another part 

 Moving text from one part of the document to another part 

 Deleting unwanted text. 

 

Before exploring all these editing features of Word detail, let us discuss the word-

wrapping feature first. Incomplete words or the words that exceed right margin look very 

clumsy. With the help of word wrap feature, Word automatically wraps around the word 

in next line, when the cursor reaches the right margin. So, every time when we reach at 

the end of line, we don't need to take care of hitting the <Enter> key. The only time, we 

need press the <Enter> key is, when we want to end a paragraph or insert a blank line. 

Selecting Text 

Text needs to be selected for performing various block operations (like Copying/ 

Moving/ Deleting) on it and for easing our work. Selection of text can be done both by 

mouse as well as by the keyboard. 

 

 

 

Selecting Text by Mouse 

First of all, let's learn how to select text using a mouse.  

The various methods of selecting text by mouse are discussed below: 

1. Hold your mouse button from where you want your selection to start and drag the 

mouse either right ways or downwards. Release the mouse button at the place where you 

want your selection to end up. 

2. If you want to select a single word, then take your mouse pointer at that word and 

double click it. 

3. Paragraphs can be very easily selected by triple clicking anywhere within the 

paragraph. 

Selecting Text by Keyboard 
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Keyboard can also be used to select text. Steps of selecting text by keyboard is 

discussed below: 

1. Take the cursor at a place where you want your selection to start. 

2. Hold down the <Shift> key and move the cursor with arrow keys in the direction 

required. 

3. Release the keys at a place where you want your selection to end up.  

In this way, the text will be highlighted. 

Inserting Text 
Generally, when you startup WORD, it is in the Insert Mode, which means as text is 

typed in, the following text is pushed towards the right side. So, wherever you need to put 

in new text in your document, take your cursor at that particular location and start typing 

in. The method is exactly the same for inserting either a single character, word, line or a 

couple of lines. At times, it also might need to overwrite the pre-written text. For that 

case, press the <INS> key from the keyboard once. This would put Word in overwrite 

mode and the word 'OVR' will be displayed on the status bar at the bottom of the screen. 

Now, when the new text is typed in, the existing contents at the current cursor location 

are going to be overwritten by the new text. If you want to put yourself back in the insert 

mode, press the <INS> key once again. 

Copying Text 

‗Copying' means duplicating the contents of the document, in some other place. 

The procedure for copying text is almost the same as that of moving text with a little 

difference which is being discussed in the following steps: 

1. Select the text that has to be copied. 

2. Press <Ctrl + C> keys. Alternatively, select the 'Copy' option from the 'Edit' menu. 

3. Take the cursor wherever you want the text to be pasted. 

4. Hit <Ctrl + V> keys. Alternatively select the 'Paste' option from the 'Edit' menu. 

Overtype is 
switched on. 
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You can also use the 'Copy' and 'Paste' button available on the standard toolbar for 

copying and pasting text. With the above procedure, you would notice the same text 

appearing at two places in the same document. 

Moving Text 

Moving text means removing text from one portion of the document and placing it 

at some other location. For moving text, do the following steps: 

1. First, select the text that you want to move. 

2. Then, click at the 'Edit' menu and select the 'Cut' option. Alternatively you can also cut 

the selected text by pressing <Ctrl + x> keys. Once the text is cut, you will notice that the 

marked text disappears from the screen. Don't feel worried, your text is put on the 

windows clipboard (temporary portion, of memory) from where it can be pasted 

anywhere. 

3. Look for the place, where you want your text to be placed. Take the cursor at that 

location and hit the <Ctrl + v> keys or alternatively select the ‗Paste‘ option from the 

Edit menu. 

You can also make use of the 'Cut' and 'Paste' button from the standard toolbar for 

cutting and pasting the selected text respectively. 

Deleting Text 

A passage of text can be very easily erased off by selecting it and pressing <Del> 

key on the keyboard. A single character can also be deleted very easily by positioning the 

cursor at that particular character and hitting the <Del> key. 

If you want to scrap off only a single word from your document, select the word 

by double clicking it and hit the <DEL> key. You can also delete words by following 

commands: 

Press <Ctrl + Del> keys to delete next word from the cursor position. 

Press  <Ctrl + Backspace> keys to delete the previous word from the cursor position. 

Undo and Redo 
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If you make a mistake in ‗Word‘, you can undo the action or command. For example, if 

you accidentally delete a word, you can bring it back again. If you decide to go through 

with the action after all, you can also redo it. 

Undo 

On the Edit menu, click Undo, press Ctrl+Z or click on the Undo button on the 

toolbar.   

Word provides you with the option to undo hundreds of actions. 

To undo several actions: 

1. Click on the arrow attached to the Undo icon to list your actions. 

2. Scroll down the Undo list and click on the action you would like to 

undo. This action plus all subsequent actions will be undone. It is not 

possible to undo a single action from the middle of the list. 

Redo 

The Redo facility reverses any changes that you have made with the Undo facility. 

On the Edit menu, click Repeat <action>, use Ctrl+Y or click the Redo button on the 

toolbar. 

 

To redo several actions: 

Word provides you with the option to redo hundreds of Undo actions. Click on the arrow 

attached to the Redo icon to list your Undo actions. 

Click on the action you would like to redo. The action plus all subsequent actions will be 

redone. Every step to the required action must be redone. Note that it is not possible to 

redo a single action from the middle of the list. 

FORMATTING 

Each one of us has a hidden desire that the reader should feel interested in 

whatever we are trying to convey. So, for achieving this, a special effort is required. We 
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must give a refined look to the document. The formatting features like fonts, bullets and 

numbering, font type etc. can be used very intelligently to create this impact. Now, let us 

learn about these special features. 

Formatting Text 

Defining Font Type and Size of Text 

A font can be defined as a set of letters that has a common or the same typeface. 

Different font types and sizes can be applied using the formatting toolbar or the Format 

menu. Let's discuss them one by one. The following figure shows you the formatting tool 

bar. 

 

Using Formatting Toolbar 

The formatting toolbar contains most of the tools that are used to give a complete 

look to the document. The toolbar contains font type, size for the text. It also displays the 

effects (Bold, Italic and Underline) that can be given to a text. For applying a font type 

and size to the text, using formatting toolbar, follows the step: 

1. Select the text. 

2. Click at the arrow beside the font type box and select a font type of your choice from 

the drop down list. 

3. Again, click at the arrow beside the font size box and select an appropriate font size 

from the drop down list. 

Using Format Menu 

The required font type and size can also be applied to the text by using 'Format menu‘ as 

described in following steps: 

1. Select the text. 

Font 
Font 

Size 

Bold Italic 
Underlin

e 

Font Color 
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2. From the 'Format' menu, select the 'Font' option. The 'Font' dialog box appears on the 

screen as shown in Figure. 

 

Figure 8 Font Dialog Box 

3. Choose appropriate font type from the 'Font' box. You can move up or down in the 

'Font' box with the help of up and down arrow keys. 

4. Similarly, choose the required font style and size for your text from the 'Font style' and 

'Size' boxes respectively. 

5. The preview of the selected text can be seen in the 'Preview' window with the applied 

formatting features. 

6. Click <OK> button. 

Now the text will be changed with the applied new font type, style and size. 
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Making Text Bold, Italic and Underlined 

Using Formatting Toolbar 

If you have given a keen look at the formatting toolbar: then you must have 

observed three buttons showing the letters B, I and U. The letter 'B' stands for Bold, 'I' for 

Italic and 'U' for Underline (Refer Figure). In order to make your text look a bit darker 

than the rest of the document, concentrate on the 

following steps: 

1. Select the text.  

2. Click at the 'B' button.  

On carrying out these steps, the 'B' button becomes 

depressed or lightened. If you do not want the text to 

be bold select the text again and click at the 'B' button. This button on the toolbar again 

becomes prominent and your text is not bold anymore. 

At times you would like to see your text in italics or would like to underline it. To do this, 

do the following steps: 

1. Select the text. 

2. Click at 'U' button to underline and 'I' button to italicize it. 

Using Format Menu 

Alternatively, the same work can also be done using the 'Format' menu by following 

steps: 

1. Select the text. 

2. Click at the 'Font' option of the 'Format' menu. 

3. In the 'Font' dialog box, activate the 'Bold' option or 'Italic' option from the 'Font style' 

box to show your text in bold or italics. (Refer Font Dialog Figure) 

4. In order to underline the text, select the required option from the 'Underline' box drop 

down list. 

We can do the same thing using key board shortcut keys after selecting the text.  

Figure 9 Formatting and Aligning 

Buttons 
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 Press <Ctrl + B> keys to bold the text 

 Press <Ctrl + 1> keys to italics the text 

 Press <Ctrl + U> keys to underline the text 

Changing Case of Text 

Word offers a quick and handy way to change the case of your text. Lowercase 

characters can easily be changed to uppercase by hitting <Shift + F3> keys. To achieve 

the contrary effect, press the <Shift + F3> keys again. This would convert uppercase 

characters to lowercase. 

Alignment of Text 

Text alignment means placement of text between the margins. The text can be left, 

right, centre aligned or it can be justified within the margins. Left alignment of text would 

mean the arrangement of text evenly in a straight line at the left side of the document but 

with uneven edges on the right side. Right aligned text is just the opposite of left aligned 

text with text evenly arranged at the right edge of the document but uneven from the left 

side. Justified text would involve even edges of text along both margins. Centre aligned 

text means that the text is placed exactly in the centre of the page. Centre aligned text is 

most suitable for giving titles, headings etc. Generally and most frequently the text is left 

aligned because then the text becomes easily readable and understandable. 

Now, let us find out how text can be aligned using the formatting toolbar. 

1. Select the text (it could be a single line or a paragraph or the whole document). 

2. Click at any of the alignment buttons from the formatting toolbar to get the desired 

result. (Refer Figure ). 

We can do the using the following keyboard shortcuts after selecting the text: 

 Press <Ctrl + L> keys to left align the text 

 Press <Ctrl + R> keys to right align the text 

 Press <Ctrl + J> keys to justify the text 

 Press <Ctrl + E> keys to show the text in the centre 

Formatting Paragraphs 

Formatting action on a paragraph decides the alignment and the spacing between 

the lines. In order to carry out formatting on Paragraph, it should be selected first. 

Then go to the 'Format' menu and do the following steps: 
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1. From the 'Format' menu, select 'Paragraph' option. A 'Paragraph' dialog box shoots up 

on the screen as shown in Figure 

 

Figure 10 Paragrah Dialog Box 

 

2. Select the alignment by clicking on the dropdown arrow of the ‗Alignment‘ box. The 

whole of the paragraph can be left, right, justified or centre aligned. 

3. Go to the 'Line Spacing' box and click at the drop down arrow to make a choice. 

Finally click at the <OK> button.  

In the 'Line Spacing' box there are many options. that need a bit of elaboration. For 

the options 'At least', 'Exactly' and 'Multiple', a number has to be given in the 'At' box. In 

these cases, the space is measured (between the lines) in terms of print size. The ‗At 

least‘ option uses the space as given in point size but it can also use some extra space in a 

case where it needs accommodate some text. 'Exactly' option gives exactly the same 

space as defined in the ‗At‘ box. If word needs extra space to adjust some more text, then 
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it cannot get it. 'Multiple' option allows you to specify the line spacing of your own 

choice. If you want the lines to be triple spaced, then type '3' in the 'At' box.  

Bullets and Numbering 

It is always advisable to put the text entries which are separated by commas in the 

bulleted or the numbered form. Adding bullets to the text makes it easy to read and 

understand. Major points can be well emphasized through this technique. Points put in 

the order of preference are long remembered by the reader. You can put bullets or 

numbers in an existing list by using either the formatting toolbar or the 'Format' menu. 

Using Formatting Toolbar  

1. Select the text. 

2. Click at either the 'Bullets' button or the 'Numbers' button on the formatting toolbar. 

(Refer Figure ).  

In case you decide that you don't require 'numbers' or 'bullets', you can very easily 

put them off by repeating the above 

steps. 

Using Format Menu 

This method perhaps offers a 

wider choice of symbols other than 

the typical black circle. Let us 

discuss this method: 

1. Select the text. 

2. Select the 'Format Bullets and 

Numbering' option. 

 

A 'Bullets and Numbering' dialog box appears on the screen as shown in Figure above. 

Select the 'Bulleted' tab in case you want bullets in your document. If you wish to put 

numbers then select the 'Numbered' tab. Choose any of the bullets or numbers and apply 

it onto your document by clicking <OK> button.  
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Find and Replace Commands 

'Find' and 'Replace' do not have their own separate dialog boxes. Instead they have been 

presented in the tab form in the same window. On finding a word, you can replace it with 

some other word using 'Replace' straightaway. Carry out the following steps for finding a 

word or group of words: 

1. From the 'Edit' menu, select the 'Find' option. A 'Find and Replace' dialog box appears 

on the screen as shown in Figure 2.40. 

2. Enter the word or phrase you want to search for in the 'Find what' box. 

3. Click at 'Find Next' button. It will show you the first appearance of word or phrase. 

Keep hitting the 'Find Next' button until you find the required word or phrase in your 

document 

 

Figure 11 Find and Replace dialog Box 

Once the word is located, you may want to replace it with some other suitable word. At 

times, global replacements of a word in the whole document have to be carried out. For 

example, you have entered a word ‗component‘ many a times in your document. Now at 

later point of time, you may want to change it to 'part'. Replace can help you in making 

the required changes by carrying out the following steps: 

1. Select 'Edit - Replace' option. A 'Find and Replace' dialog box comes on the screen as 

shown in Figure. 
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Figure 12 'Find and Replace' Dialog Box 

 

2. Enter the word 'component' in the 'Find what' box. 

3. Enter 'part' in the 'Replace with' box. 

4. Click 'Find Next' if you want to see the first occurrence of the word. Click the 'Replace'  

button if you want to change it. In case you do not want to make the change, then click 

'Find Next' again to locate for the next appearance of the word. 

5. The 'Replace All' button will change all the occurrences of the word 'component' to 

'part' in the whole document in a single command. 

Numbering Pages 

A long document certainly needs proper page numbering done for easy and quick 

reference. Adding numbers to each and every page manually is a tedious confusing time 

consuming work. Word can really automate your task. To add numbers to your 

document, follow the steps given below: 

1. Click at the 'Page Numbers' option of the 'Insert' menu. A 'Page Numbers' dialog box 

appears on the screen. This dialog box resembles Figure 

 

Figure 13 'Page Numbers' Dialog Box 
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2. In the 'Position' box, click at down arrow and select the desired position where you 

want the page number to appear. It can come either at the top or bottom of the page. 

3. From the 'Alignment' box, decide the alignment of the page number. You can place the 

page number either on the left, right or in the centre of the page. 

4. If you want that the page number should be shown on the first page also, then check 

the box on. In case you check the box off, then the page number not shown in the first 

page but it is certainly counted as 1. 

5. Click at the 'Format' button. A 'Page Number Format' dialog box appears on the screen 

as shown in Figure. Select the style of page 

numbers that you want for your document from the 

'Number Format' drop down list. 

6. If you want to start the page number from some 

digit other than 1,2,3..., then you can very well 

specify it in the 'Start at' button, Click at the 'Start 

at' radio button and type in the desired number in 

the following box from where you want the, 

numbering to start. 

7. Click <OK> button to apply the desired format. 

Again click at <OK> button to save the changes and 

come out of the 'Page Number' dialog box. 

Clip Gallery 

Word has enhanced graphic capabilities and it has many built-in clips and 

multimedia effects such as sound and videos called Clip Gallery. 

Inserting Clips 

To place clips in your 

document, do the following 

steps: 

1.Select 

Insert/Picture/Clipart'. A 

Figure 14 Page Number Format' Dialog 

Box 
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dialog box by the name 'Microsoft Clipart Gallery' is shown on the screen as shown in 

Figure  

 

Now, from this dialog box, select the 'Clipart' tab. You will notice that the clipart gallery 

is indexed on major keywords. If you scroll down the window under the head 'All 

categories', you would find a fairly long list of clips. So, in order to make your search 

easier, select any particular category in the category list. In the adjoining window, you 

would find all the clips relating to that category together. 

2. Search through the clips and decide an appropriate clip for your document. Select 

anyone desired clip and click at the <Insert> button. You will find that particular picture 

placed in your document at the current cursor position. 

Resizing Clips 

The clip that you have successfully placed in your document might not be of the exact 

size that you want. It can either be too small or too big. So, to resize it: 

1. Select the clip by clicking anywhere on it. Eight sizing handles appear on the boundary 

of the clip  

2. Take your pointer at any of these handles. The pointer will change into a double 

headed arrow. 

3. Click and drag the handle in the direction desired to make your clip big or small. 

4. Release the mouse pointer when the required size of your clip is achieved. 

PAGE SETTING 

Page setting includes putting the text neatly between margins. Margins are nothing but an 

invisible frame within which the whole text appears. When a blank new document is 

opened, a default margin is always there. This margin is laid for sides, top and bottom of 

the page. You can always change the default settings of Word according to your demand 

and requirements. We will set margins by two methods: 
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Margin Setting through File/Page Setup 

The default setting of the top 

and bottom margin is 1 inch and in 

the sides, it is 1.25 inches. To 

modify the default margin setting, 

follow the steps given below: 

1. Select 'Page setup' option of 'File' 

menu. A 'Page Setup' dialog box 

appears on the screen as shown in 

Figure  

2. Click in the 'Top' box and erase 

off the current setting by using either the <Del> key or the <Backspace> key from the 

keyboard. Type the desired number. Alternatively, you can use the top arrow to increase 

the margin and down arrow to decrease it. 

3. Similarly, change the settings in the Bottom, Left and Right boxes as well. 

If you want the changes that have been made recently should apply to the current 

document only then click at <OK> button. But in case, if you want that changes to the 

current document as well as any other new document that you open means click at the 

<Default> button. Then click the <Yes> button in which case ‗Word‘ is trying to seek 

your permission to change the default settings for page setup. 

Setting Margins using Ruler line 

Ruler line is very frequently used to change margins. It is a quick and easy way to 

set margins but needs some amount of practice also. To set margin using the ruler line, 

carry out the following steps: 

1. Place your mouse pointer on the left side of the horizontal ruler line. Slowly, move the 

mouse pointer towards your right side till the place where your mouse pointer acquires 

the shape of a double-headed arrow.  

 

 
Left margin Right margin 
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2. Click at that location and drag the mouse towards right side to increase the margin or 

on the left side to reduce it. 

3. Release the mouse button when suitable margin is attained. 

In order to set right margin, the method is just the same as discussed in the above three 

steps. If you observe closely, you will find a thin gray line above the 'Right Indent' button 

which is in the extreme right of the Ruler Line. This is the Right Margin Line. Place the 

mouse pointer at this line and click on it. Drag the pointer in either direction to increase 

or decrease the right margin. Finally, release your mouse button. 

Now, let us learn how to set the top and bottom margins using the vertical ruler line. This 

vertical ruler line appears only in the Page Layout view. So, in a case if the vertical ruler 

line is not apparent on the screen, then first switch yourself to Page Layout view by 

selecting 'Page Layout' option from the 'View' menu. To set the top margin: 

1. Take your mouse pointer on the thin gray line that appears between the darkened and 

white areas on the top side of the vertical ruler line. 

2. As soon as your mouse pointer takes the shape of a double headed arrow, click and 

drag it either upwards or downwards to attain the desired top margin. 

3. Release the mouse button. 

When you are trying to work with the margins, a line is shown across the page which 

keeps moving up or down according to the movement of your mouse pointer. This gives 

you the exact location of your margin on the page. 

Headers and Footers 

  A header is a block of text that is printed at the top of every page on a document. 

Footer, on the other hand, is a block of text that appears at the bottom of every printed 

page.  

Creating headers/footers  

1: click on view drop down menu 

 2: click on header and footer 
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3: place your cursor in the box that says header, not footer. 

 

4: click align right 

 

 

5: Type the Text you want 

 

6:To insert page number press the # insert page number button.  

 

7: press the close button on the Header and Footer toolbar  

USING TOOLS 

 Word contains various tools such as spelling and grammar checking, word count 

etc., for making the document error free. 

Spelling and Grammar checking 
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The spelling and grammar checker checks spelling and grammar in the active document, 

including text in headers, footers, endnotes, and annotations. 

Word contains a dictionary used to check spellings. Although the dictionary contains a 

very large number of words, it does not contain all possible words and spellings. The 

grammar-checker identifies sentences that have possible grammatical errors or a non-

standard writing style. These facilities should not be relied upon entirely – there is no 

substitute for proof-reading a document. 

Word checks your entire document, starting at the position of the insertion point. 

However, if you select text, Word checks only the text that you have selected. 

Use the Esc key to stop the checking process. 

Checking spelling and grammar as you go 

Spell-checking is not automatically turned on in Word. If you would like to check your 

spelling and grammar as you type: 

On the Tools menu, chose Options and then select the Spelling and Grammar Tab. 

From here you need to click on Check spelling as you type and Check grammar as you 

type. 

Once they have been turned on, any spelling mistake will be underlined in red and 

grammatical errors will be underlined in green as you type. 

Spell-checking a document  

On the Tools menu, click Spelling and Grammar to display the Spelling and Grammar 

dialog box. 

Any word not found in the dictionary is displayed in red in its original sentence in the Not 

in Dictionary box. Where applicable, a list of alternative suggestions is shown in the 

Suggestions box. 
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For each word displayed in the Not in Dictionary box, click the appropriate button (for 

guidance, see below). 

If none of these choices are appropriate you can manually edit a word in the Not in 

Dictionary box.  

You will need to click the Change button to confirm any changes. 

Spelling and Grammar dialog box options 

 Leave the word unchanged. 

 Leave the word unchanged throughout the document. 

 Add the word to the custom dictionary specified. 

 
Accept the spelling selected in the Suggestions box, or replace the 

misspelled word with the spelling you type in the Not in Dictionary box. 

 
Replace all instances of the original word with the spelling selected in 

the Suggestions box, or the spelling you type in the Not in Dictionary box. 

 Add the misspelled word and its correction to the AutoCorrect list. 

 Delete the second occurrence of a repeated word. 

 

Grammar checking 

The word not found in 
the dictionary is 
displayed in red within 
the sentence. 

Choose from the list of 
Suggestions. 

Click Ignore Once to 
ignore the misspelling. 

Click Change to accept 

the highlighted spelling 
in the Suggestions box. 

Click Add to Dictionary 

to add the word to the 
custom dictionary. 
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A sentence that has possible grammatical errors will be displayed in green in the Spelling 

and Grammar dialog box. Where applicable, a list of alternative suggestions is shown in 

the Suggestions box. 

For each sentence displayed in the Grammar box, click the appropriate button. 

 
Ignore this occurrence of the error in the sentence and continue 

checking. 

 Ignore the grammatical rule. 

 Ignore this error and skip to the next sentence. 

 Accept the sentence selected in the Suggestions box. 

When the spelling and grammar-checking process is over, click the OK button to return to 

the document. 

The following options are available in the Spelling and Grammar dialog box: 

 Cancel the spelling- and grammar-checking process. 

 

Undo the previous correction. It is possible to undo all corrections 

made in the current spelling- and grammar-checking process in reverse 

order. 

 Allows you to change spelling- and grammar-checking options. 

 

Word Count 

This is useful if you want to view the statistics of your document, 

for example, how many words or paragraphs are in the document. 

On the Tools menu, choose Word Count. 

The Word Count window appears with the statistics of your 

document displayed. 

To have a permanent word counter displayed on your screen, click on the Show Toolbar 

button. 
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Each time you add text to your document, you will need to click on the Recount button 

on the Word Count toolbar to show the total amount of words.  

TABLES 

Tables are a handy way to format all kinds of documents that you might create for 

analyzing a test and to grade reports. You can quickly create a simple table by using the 

Insert Table command or you can use the Draw Table tool to quickly create a more 

complex table—for example, one that contains cells of different heights or a varying 

number of columns per row. Using Draw Table is similar to drawing a rectangle on graph 

paper—first draws a line from one corner of the table to the corner diagonally opposite in 

order to define the boundary of the entire table, and then draw the column and row lines 

inside. 

You can also use tables to perform some of the tasks you might use a spreadsheet 

for. For example, you can sort table entries in alphabetical, numeric, or date order. You 

can also total a row or column of numbers in a table, as well as perform other 

calculations, such as averaging, counting, etc.  

WORKING WITHIN TABLES 

A table is made up or rows and columns and contains cells that you can fill with numbers, 

text, pictures, graphics, other tables, and more. 

Inserting Table 

To insert a table do the following step 

1. Place the pointer in the text where you want to insert the table. 

2. Click Table menu, then select Insert/Table option. A dialog box appears as shown 

below. 

3. Select a number of columns and rows and AutoFit 

features. For example, you might only want 2 

columns and 10 rows. 

4. Now a table with 2 columns and 10 rows get 

inserted. 

You can enter text, pictures, or even other 

tables into the cells in this table. Use the arrow keys 
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to move around in the table. You can resize the rows and columns of the table. To adjust 

the size of the table, move the pointer over the vertical line that separates the columns in 

the table and double-click it to automatically fit the text. Do the same to the vertical line 

on the right side of the column. Or, you can resize the columns by selecting Cell Height 

and Width from the Table menu and then selecting Auto fit. 

Formatting Table 

 To add a border to the table,  

1. Click anywhere in the table and on the Format menu, click Borders and Shading. 

2. Click the Borders tab. 

3. Specify which borders you want to show or click ‗None‘ to hide the borders. 

4. Click OK. 

The Tables and Borders Toolbar 

The Tables and Borders toolbar will appear as a floating toolbar after you insert a new 

table. The Tables and Borders toolbar will be very useful when you are using tables in 

various parts of your document. Remember that you can dock the toolbar or you can 

make it a floating toolbar. 

 

Figure 15 Tables and Borders Toolbar 

S.No Tool Name Action 

1  Draw Table  Allows you to draw a table by clicking and dragging. 

2  Eraser  Allows you to erase lines in the table. 

3  Line Style  Allows you to pick a style for the borders of the cells. 

4  Line Weight  Allows you to pick the thickness of the borderlines. 

5  Border Color  Allows you to pick a color for the borderlines. 

6  Border Allows you to apply borders to selected cells. 
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7  Shading Color  Allows you to shade a cell (or cells) in a table. 

8  Insert, Table  Allows you to insert a table using the Insert Table box. 

9  Merge Cells  Allows you to merge connected cells together to form one cell. 

10  Split Cells  Allows you to split a cell into multiple rows and columns. 

11  Align  Allows you to align text, pictures, tables, or objects in a cell. 

12  Distribute Rows 

Evenly 

Makes all rows the same height. 

13  Distribute Columns 

Evenly 

Makes all columns the same width. 

14  Table Auto Format Allows you to utilize predefined formats in a table. 

15  Change Text 

Direction 

Allows you to change horizontal text to vertical text or vice versa 

16  . Sort Ascending Sorts a list in A-Z order 

17  Sort Descending Sorts a list in Z-A order. 

18  AutoSum Quickly totals a row or column of numbers. 

 

Draw Table 

1. From the menu choose: Table, Draw Table. Alternatively to draw a table, you can 

also use the Draw Table icon on the Tables and Borders toolbar. Then the cursor 

becomes a pencil. 

2. Drag the pencil pointer to create the outline of the entire table 

3. To add rows, draw horizontal lines from one side to the other by dragging the pencil 

pointer. Repeat until all rows have been added. 

4. To add columns, draw vertical lines from the top to the bottom of the table border with 

the pencil pointer. Repeat until all columns have been added. 

5. To split a cell that does not span the entire width or height of the table, draw a dividing 

line in just the cell you want to separate. 

6. To turn off the pencil cursor, re-navigate to the menu option of Table, Draw Table. 

Tip: You can add new rows to a table by using the Tab key in the cell at the bottom right 

corner of the table. This will give you a row that is the same as the previous row. If you 

want to create or use tabs within a cell, press Ctrl + Tab 
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Unit 4: Spreadsheet Software 

INTRODUCTION 

Business applications require a lot of calculation work. In manual system, it is done on a 

sheet of paper with rows and columns, which is called a 'spreadsheet'. Spreadsheet 

packages use the concept of an electronic spreadsheet. An electronic spreadsheet (or 

worksheet) is a very big sheet consisting of thousands of rows and columns, which is 

used to store information in the memory of a computer. Like databases, electronic 

spreadsheets have now become an essential tool in developing a computerized 

management information system. Income statements, annual reports, balance sheet, cost 

analysis and budgets are some of the applications where worksheets are typically used.  

What is spreadsheet? 

A spreadsheet is an interactive computer application for organization, analysis and 

storage of data in tabular form. Spreadsheets are developed as computerized simulations 

of paper accounting worksheets. The program operates on data entered in cells of a table. 

Each cell may contain either numeric or text data, or the results of formulas that 

automatically calculate and display a value based on the contents of other cells. A 

spreadsheet may also refer to one such electronic document. 

Popular Spreadsheet Packages 

The popularly used spreadsheet packages are: 

 MS-EXCEL 

 Lotus 123 

 Supercalc 

 Framework 

 VP Planner Plus 

Uses of Electronic Spreadsheets 

Electronic Spreadsheets satisfy the needs of a large number of users and meet with their 

varied requirements. Some of the things that can be easily done with the help of an 

Electronic Spreadsheet are mentioned below: 

 Arithmetic and Statistical Calculations 
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 Preparation of Profit and Loss Account 

 Preparation of Income Statements 

 Preparation of Tax Statements 

 Reports 

 Charts 

 Regression Analysis 

 Forecasting 

An Electronic Spreadsheet can do a great job with mind crunching numbers. Any kind of 

complex calculation can be done in a matter of few seconds. 

CREATION OF SPREADSHEET APPLICATION: MS 

EXCEL 

EXCEL is a very powerful and easy to use spreadsheet package which is being 

commonly used these days. It is basically an end user application package. It works very 

well with numbers and their complex calculations. EXCEL helps to put and prepare the 

data in an organized, orderly and meaningful fashion. EXCEL finds its major 

contribution in creating reports, using formulas and performing calculations. It is best 

suited for scientific and statistical analysis. EXCEL can also be used to prepare Profit and 

Loss accounts, Balance Sheet and other Tax statements. It works well for both simple and 

complicated numbers. It can be used for preparing analytical reports including statistical 

analysis, forecasting and regression analysis. Good looking and attractive charts can be 

created which depict data in clearer and meaningful fashion.  

Starting Excel 

The biggest advantage offered by Microsoft Office products is the great similarity 

between its applications with respect to the overall working, toolbars and menus. Since, 

we have already made ourselves familiar with Word, learning EXCEL will become easy 

and less time consuming for us. 

To startup EXCEL in Windows, the steps given below can be followed: 

1. Click on the Start button at windows taskbar. 

2. Select Programs option 
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3. Select Microsoft Excel option. 

Once EXCEL is loaded, a blank workbook shoots up on the screen. A typical name given 

to a file in EXCEL is Workbook. The terms Excel Document, Excel Workbook and Excel 

File carries the same meaning and can be used interchangeably. This blank file by default 

gets the name - Book l. The extension given to a file in Excel is 'XLS'.  

Menus, buttons and whitespace 

When Excel is open, you should see something that looks like this on your screen (but 

more of it): 

 

The general areas of Excel are divided into the following sections: 

Title bar – The blue bar displays the program and file name. 

Menu bar – The text menus at the top of the window let you access the program‘s 

features and tools. To open one of these menus, just left-click the menu name. 

Button bar – The buttons are quick shortcuts to common tasks such as saving, printing, 

and many others.  

Formula bar – The blank line running across the screen immediately above the grid-like 

data area. It displays the contents of a cell. 
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Data area – The grid-like area occupying most of the screen. It holds all data entered 

into Excel. 
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The data area 

Excel lays its data out in an array of rows and columns, similar to graph paper or what 

you might seen in an accounting 

ledger… except that Excel‘s data area is 

far bigger than any sheet of paper you‘ll 

ever come across! The data area is made 

up of 256 columns and 65,536 rows. 

Each cell is designated by a row index (a 

number) and a column index (a letter). 

So the rst cell in the upper left corner of the spreadsheet is cell A1, and the two cells 

indicated in the following image are cells B5 and D4.  

As mentioned earlier, there are 256 columns, and the columns are labelled 

alphabetically—but there are only 26 letters in the alphabet. When Excel run out of 

letters, Excel start repeating: cell AA1 is just to the right of cell Z1. This continues until 

we reach the 256th column, column IV. With all 256 columns and 65,536 rows, we‘ve 

got over sixteen million cells to play with. 

Working with cells 

Cells contain data. There are three different types of data that Excel recognizes: 

• Text – Letters and most typographical symbols—basically, anything that‘s not a 

number or a formula. 

• Numbers – The ―numbers‖ type of data consists of… you guessed it, numbers. The 

rst character you enter must be either a number or a special symbol like a dollar sign ($) 

or a decimal point (.). 

• Formulas – Functions that operate upon the contents of other cells and produce output. 

Formulas must always start with an equals (=) sign. 

A single cell cannot contain more than one type of datum. 

 

The active cell is indicated by a dark border 

and functions much like the cursor in a word 

processor. It designates where any data you 

enter will be placed. In the image, the active 

cell is cell C3. If you were to start entering 
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data, anything that you entered would appear in cell C3.  

To move the active cell: 

…using the mouse 

• Left-click the cell you want to make active.  

…using the keyboard 

• Press the arrow keys to move the active cell. 

Once you‘ve moved into cell C3, try entering a text label. A sample text label is shown at 

right. 

To create a text label: 

1. Select a cell to make it active. 

2. Enter some text. 

3. Press Enter when done. 

 

If things don‘t seem to work right, press Esc a few times and then try again. 

Notice how the label in cell C3 extends into cell D3. This happens for two reasons: 

 

1. The label in cell C3 is longer than the width of column C. 

2. The cell immediately to the right of cell C3 (which is cell D3) is empty. 

 

If either one of these conditions is false, the label in cell C3 will not extend into D3; it 

will be truncated (cut off) at the column boundary. To correct this, you can resize the 

column containing the cell. 

To resize columns and rows: 

1. Move the cursor over the boundary between two columns (they are labeled A, B, C, 

etc.). The cursor becomes a double-headed arrow. 

2. Click and drag in either direction until the column is as wide as you want. 

Changing Row Height 

 

1. Select the row whose height has to be changed. This can be done by either clicking in 

any cell of that particular row or by clicking at the row header. 

2. From the ‗Format‘ menu, select the 'Row' option. Then, choose 'Height‘. 
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3. Enter the height of the cell that you want to achieve. 

In order to change the height of a group of rows, select all those rows. From the 'Format' 

menu, select the 'Rows' and then the 'Height' option. Type the desired row height. All the 

selected rows will have the same row size. 

Changing the Column Width 

 

On similar grounds, the width of a column can also be altered. Column width can be re-

adjusted according to your own special requirements. Thus, for changing the column 

width, carry out the steps given below: 

1. Select the whole column either by clicking at the column header or by clicking at any 

cell of that particular column. 

2. From the ‗Format‘ menu, choose the 'Column' option. It will display a 'Column‘ Width 

dialog box on the screen. 

3. Type in the new column width. Finally, click at the <OK> button 

Moving and Copying Text  

The contents of a cell or range of cells can be moved as well as copied to some other 

location in the worksheet. Copying cells mean duplicating the contents of a cell or range 

of cells at some other desired place. Moving text means removing text from one portion 

of the worksheet and placing it at some other location. The procedure for copying and 

moving text is almost the same with a little difference. For copying cell contents, follow 

the steps given below: 

1. Select a cell or range of cells. 

2. Press <Ctrl + C> keys. Alternatively, select the 'Copy' option from the 'Edit' menu. 

3. Take the cursor to the cell wherever you want the text to be pasted. 

4. Hit <Ctrl + V> keys. Alternatively, select the 'Paste' option from the 'Edit' menu. 

You can also use the 'Copy' and 'Paste' button available on the standard toolbar for 

copying and pasting text. On similar grounds, for moving the cell contents, select the 

'Cut' option instead of 'Copy' from the 'Edit 'menu. Rests of the steps are the same as that 

of copying cell contents. 
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Inserting a Row 

In order to insert a new, blank row in between two rows, follow the steps given below: 

1. Take the cursor where a new row has to be inserted. 

2. Select ‗Rows‘ option from the ‗Insert‘ menu. A blank row will be inserted above the 

current row. 

Inserting a Column 

To insert a blank column, the steps given below can be followed: 

1. Take the cursor where a new column has to be inserted. 

2. Select ‗Columns‘ option from the Insert menu. You will find a new blank column 

inserted to the left of the current column. 

Deleting a Cell or Group of Cells 

In order to delete a single cell or group of cells, follow the steps given below: 

1. Select the cell or range of cells that is to be deleted. 

2. Right click your mouse button. 

3. Choose the 'Delete' option from the popup menu that appears. 

Clearing the Contents of a Cell or Group of Cells 

To clear or erase off the contents of a single cell or group of cells, carry out the steps 

given below: 

1. Select the desired cell or range of cells from which the contents are required to be 

cleared. 

2. Right click the mouse button. 

3. Choose the 'Clear Contents' option from the popup menu that appears on the screen. 

Clearing the contents of a single cell or range of cells is different from deleting them. 

When you clear a cell or range of cells, the contents are erased, leaving the cells blank. 
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However, when a cell or cell range is deleted, the other cells re-adjust themselves to fill 

in the empty space created by deleting them. 

Autofill 

 

Autofill tool offered by EXCEL helps you to repeat a cell entry. It looks at the 

series entered by you in adjacent cells and tries to complete it for you. For example, if 

you want to enter the labels for all the twelve months of a year simply, type in first two 

entries, i.e., Jan. and Feb. in two adjacent cells. Then, highlight both the cells by selecting 

them. Take your mouse pointer at the bottom right corner of the selected cells. Your 

mouse pointer is going to take the shape of a + (plus) sign. This plus sign is called 

Autofill handle. Drag your mouse pointer either across or downwards for those many 

cells till you wish to continue the series. Autofill keeps filling the series till the time the 

mouse pointer is dragged. So, you are saved the effort of keying in the labels of the rest 

of the months. While using Autofill, you can drag the mouse pointer up, down, right or 

left.  The following are some of the example that can be used for autofill. 

(i) Monday, Tuesday..... 

(ii) 10, 20, 30..... 

(iii) 1, 2, 3..... 

(iv) AI, A2, A3.... 

(v) 5:10, 5:20.... 

FORMULA 

Formulae allow the calculation of data or values. These calculations range from 

simple arithmetic (addition, multiplication etc.) to more complex statistical, logical and 

database functions.  

Creating simple formulae 

You enter a formula by typing it in the cell where you want its result to appear.  

When you confirm entry of a formula, Excel will display the result on the worksheet, but 

the underlying calculation appears in the formula bar. 
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Formulae always start with an = (equals) sign.  

Place the formula in the cell where the result is to be displayed. 

Formulae should refer to the cell address not the contents of the cells,  

i.e. to add the two numbers shown above the correct formula is:  

=A1+A2  

not 

=10+15 

 The result is displayed in the cell when the Tick button on 

the formula bar is clicked, or the Return key is pressed. 

 You can cancel a formula if necessary by clicking on the 

red X button on the formula bar or pressing the Esc key. 

 When the contents of a cell referred to in a formula 

change, the formula automatically calculates and displays 

the new result. 

I.e. if the value in cell A1 is changed to 15 in the example above, the formula 

automatically recalculates to display the result 30. 

Some common formulae 

 

Operator Description Excel Formula 

+ Addition  =A1+A2    add A1 and A2 

- Subtraction  =A1-A2     subtract A2 from A1 

* Multiplication  =A1*A2     multiply A1 by A2 

/ Division  =A1/A2     divide A1 by A2 

^ Exponential  =A1^A2    raise A1 to the power A2 

% Percentage  =A1 %       express A1 as a percentage 

These operations can also be combined together. For example: 

Click here to 
show the result 
or press Return.  
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Formula Result 

=3+2*4 11 

=(3+2)*4 20 

 

 =A1-A2/(A1+A2) 

or 

 =(A1+B2–D4)*50 

Use brackets to ensure that the different parts of the formula are calculated in the correct 

order. For example =(3+2)*4 is not the same as =3+2*4. 

The order of precedence 

Excel evaluates operators following the conventional rules – it will apply the calculations 

in a formula in the following order:  

BODMAS:  Brackets Of Division Multiplication Addition Subtraction 

( ) brackets first 

/ and * division and multiplication 

+ and - addition and subtraction 

 

Take care to observe these rules when creating your own 

formulae.  

Incorrect syntax will result in error. 

Calculation with dates 

Excel also allows you to perform calculations with dates. All dates are stored in Excel as 

sequential numbers. By default, January 1 1900 is serial number 1, and January 1, 2004 is 

serial number 37987 because it is 37,987 days after January 1, 1900. Excel stores times as 

decimal fractions because time is considered a portion of a day. 

Because dates and times are values, they can be added, subtracted, and included in other 

calculations. You can view a date as a serial value and a time as a decimal fraction by 

changing the format of the cell that contains the date or time to General format. 

Viewing dates as numbers 
To view dates as numbers: 

1. Select the cell and click Cells on the Format menu.  

2. Click the Number tab, and then click Number in the Category box. 
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Calculating the difference between two dates 

In the following example the date in cell B1 

has been subtracted from the date in cell B2. 

The result in cell B3 has been formatted to 

display a number (the number of days 

between two dates) with no decimal places.  

 

Editing a formula 

1. Double-click on the cell containing the formula. The cell will switch from displaying 

the result of the formula to the formula itself. 

2. Click the mouse over the part of the formula you wish to change to insert the cursor 

there. Type any new character or use the Backspace or Delete keys to remove 

characters. 

3. Press Enter to confirm your changes, or Esc to exit the cell without saving your 

changes. 

or 

1. Move to the cell containing the formula you wish to change. 

2. The formula will be displayed in the formula bar. 

3. Click into the formula bar and make the necessary changes. 

4. Click on the green tick to the left of the formula to confirm your change, or the red 

cross to close the formula without saving your changes. 

or 

1. Move to the cell containing the formula you wish to change and press the F2 key. 

2. Use the arrow keys to move the cursor to the edit position. Make your changes and 

exit the cell as explained above. 

Copying formulae 

Formulae can be copied using the Copy and Paste buttons in the same way as data can be 

copied in a worksheet. 

1. Select the cell containing the formula to be copied. 

2. From the Edit menu choose Copy (or use the Copy icon). 
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Notice how the 
reference 
changes by one 
row relative to its 
starting position.  

Notice how the reference 
changes by one column 

relative to its starting 
position. 

3. Move the cursor to the new location. 

4. From the Edit menu choose Paste (or use the Paste icon). 

Note how the cell references change as we copy the formula from cell A2 to cell B2 

below left.  

=A1 becomes =B1 

Note how the cell references change as we copy 

the formula from cell A2 to cell A3 below right.  

=A1 becomes =A2  

When a formula is copied, it is 

applied relative to the new range.  

Therefore, the formula =A1 will 

become =A2 when copied to the next 

row, and the formula =A1 and will become =B1 when copied to the next column. 

Using the fill handle 

1. Move to the cell that has the formula that you want to fill. 

2. Position your mouse pointer over the fill handle.  It will change to a black plus. 

3. Drag the black plus down or right over the cells where you want your copied formula 

to generate results.  You will see an outline around those cells. 

4. Release the mouse when the outline includes all the cells where you want results. 

 

 

Using keystrokes 

You can fill a column or a row of formulae using the keyboard. 
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1. Select the cell containing the formula to fill and the cells where you want to copy it. 

2. Press Ctrl+D to fill down. 

or 

Press Ctrl+R to fill right. 

There are no keystrokes to fill up or left.  Instead, repeat step one above and then click 

Edit on the menu bar, choose Fill and select the direction for the fill from the resulting 

sub-menu. 

FUNCTIONS 

You have seen how to enter formulae to perform simple arithmetic operations on values 

in a worksheet. Excel also provides many built-in functions which automate a number of 

types of calculation.  Functions are pre-programmed formulae – you are probably already 

familiar with the use of functions on a calculator (for example, the square-root function, 

trigonometric functions, logarithms etc.). Excel has more than 300 functions covering a 

range of statistical, mathematical, financial and logical operations. If you have many 

numbers in a group of cells that you wish to combine in a formula, typing the formula 

becomes laborious. Using a function offers a shortcut method. 

Examples of the most commonly used functions include the Average function, which 

calculates the average of a group of cell values, the Sum function, which adds together a 

group of cell values, and the Min and Max functions, which determine the lowest and 

highest values in a group of cells. 

Functions and arguments 

Functions are usually written with the equals sign (=) followed by the function name and 

then parentheses containing the argument. Usually the argument just contains the range 

of cells which the function will operate on.  For example, the Average function is written 

as: 

= AVERAGE(A1:A4) 

The argument of a function is placed in brackets. To specify a range of cells a colon is 

used between the first and the last cell address. For example, (A1:A4) will specify cells 

A1, A2, A3 and A4. 

The Sum function 
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The Sum function is a useful function. It simply adds together a range of cell values.  The 

formula:  

  =A1+A2+A3+A4+A5+A6+A7+A8 

can be replaced by:            

=SUM(A1:A8)    

This adds up the contents of the cells A1 to A8. 

 The function can be typed at the keyboard like any other formula. 

 The function can be created with the Insert Function. 

 The SUM function can be created using the AutoSum button (this is the easiest 

method).  

AutoSum   

The AutoSum feature allows you to add all numbers in a contiguous row or column.  

To use AutoSum: 

1. Click a cell below the column of numbers or to the right of the row of numbers.  

2. Click the AutoSum button    on the 

Standard toolbar, and then press Enter.  

Excel automatically guesses the range of cell 

references that you wish to sum (these can be 

amended if necessary).  

Note: Always check automatically generated 

formulae before accepting them, as Excel doesn‘t 

always guess correctly. 

Using the Insert Function 

If you know the name of a function, you can 

simply type it in together with the argument or range of cells you want to apply it to.  

However, an easy way to work with functions is to use the Insert Function. 

1. Position the cursor in the cell which is to contain the result, and from the Insert 

menu select Function or click the Insert Function button on the Formula bar.  

2. The Insert Function dialog box 

is displayed.  

Using the Search for a function 

box, you can type a description of 

what you want to do.  The Most 
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Recently Used category often offers the most likely choices. Select an appropriate 

category. The functions in that category are shown in the lower half of the window. 

If in this example we choose AVERAGE and click on OK, the Function Arguments 

dialog box will display as shown below. It may well obscure the part of the worksheet 

you want to work on. However it can be moved simply by clicking and dragging 

anywhere in the grey shaded box. It can also be shrunk by clicking on the 

Shrink/Enlarge buttons. 

Note that Insert Function guesses the range of cells to be used in the calculation (A1:A2 

in the example). Click OK if this is correct.  Alternatively type the range in, or highlight 

the cells required in the worksheet. 

Notice that a moving border appears around the specified cells as the range is entered in 

the dialog box. Click OK. 

You can view the compleed formula by clicking in the cell, and looking at the contents of 

the Formula bar.  

Function box 

The Function box groups the most commonly used functions 

for quick and easy access.  

1. Position the cursor where you want the function and type 

an equals sign into the cell.   

2. Excel displays the Function box to the left of the Formula 

bar.  Click the drop-down list arrow to the right of the 

Function box to display a list of function names. 

3. Select the function you require by clicking its name from 

the list. 

4. If your function isn‘t listed, click the More Functions option to access the Insert 

Function dialog box. 

5. Excel will place the chosen function on the worksheet in 

the selected cell.  You can see the selected function being built 

on the Formula bar.   

With some functions, Excel tries to guess which cells you 

want included as the function arguments.  Click OK to accept 

Excel‘s guess and confirm the function, or select the correct 

cells as described above. 
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Precision formatting 

Care must be taken when working with formatted numbers. It is important to remember 

that formatted numbers, i.e. the numbers which appear on the screen, may not be the 

same as the value stored in the cell or the numbers used in calculations. The discrepancy 

can cause the results displayed to be different from the manually calculated answers.  

 

In the example, there are two columns of numbers that appear to be the same. The first 

column adds up to 95 but the second column adds up to 100. Take a close look at the 

value stored in cell A1, as displayed in the Formula bar. The value 

stored in all the cells in the first column is actually 9.5. This has 

been formatted to appear as a whole number (integer). The 

calculation is actually correct (10*9.5=95), although it appears to 

be incorrect. The problem can be avoided by using number formats 

cautiously, or it can be resolved by setting the precision for the 

entire worksheet as explained below. 

Setting the precision of number formats 

To set the precision of number formats for an entire worksheet: 

1. Choose the Tools menu, then the Options command and select the Calculation tab.  

2. Choose the Precision as displayed box and click OK.  

When you choose OK you are warned that constant numbers throughout the worksheet 

will be rounded permanently to match cell-formatting. 

Statistical & Mathematical functions 

Some of the most commonly used statistical and mathematical functions are shown 

below. 

Function  Example Description 

MAX MAX(C1:C10) Finds the largest cell value in the specified range of cells. 

MIN MIN(C1:C10) Finds the smallest cell value in the specified range of 

cells. 
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AVERAGE AVERAGE(C1:10) Finds the average cell value in the specified range of 

cells. 

MEDIAN MEDIAN(C1:C10) Finds the median or middle value in the specified range 

of cells. 

STDEV STDEV(C1:C10) Finds the standard deviation of the values in a range of 

cells. 

COUNT COUNT(C1:C10) Counts the number of cells containing numbers. 

COUNTA COUNTA(C1:C10) Counts the number of cells containing numbers or letters 

(i.e. the number of non-blank cells). 

COUNTBLANK COUNTBLANK(C1:C10) Counts the number of blank cells. 

ROUND ROUND(C1, 2) Rounds the cell value to the specified number of decimal 

places (2 in this example; use 0 to get a whole number). 

SQRT SQRT(C1) Calculates the square root of a cell value. 

RADIANS RADIANS(C1) Converts angles from degrees to radians. 

SIN SIN(C1) Calculates the Sine of an angle (in radians – use the 

RADIANS function to convert degrees into radians).  

Other trigonometric functions include COS and TAN. 

RANGE 

A range is a collection of two or more cells. In Excel, you can create names that 

refer to a single cell, a group of cells on the worksheet, a specific value, or a formula. 

After you define names, you can use the names in a formula, instead of using a constant 

value or cell references.  

Cell references 

In functions, you often need to refer to a range of cells.  The way Excel displays cell 

references in functions depends on whether the cells you want the function to act upon 

are together in a block, or in several non-adjacent cells or blocks. 

The table below explains how to use different operators to refer to cells: 

Operator Example Description 
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Reference 

operator  : 

(colon) 

B5:B15 Range operator that produces one reference to all the 

cells between two references, including the two 

references. 

,   (comma) SUM(B5:B15,

D5:D15) 

Union operator that combines multiple references into 

one reference.  

  (single 

space) 

=B5:B15 

A7:D7 

Intersection operator that produces one reference to cells 

common to two references. In this example, cell B7 is 

common to both ranges; therefore the result would be 

the contents of cell B7. 

Absolute cell referencing  

The ability to copy formulae from one location to another in a spreadsheet can save you a 

significant amount of work. Normally, if you copy a formula involving a cell reference to 

another location, the cell reference is adjusted relative to its starting point. So, for 

example, copying a formula calculating the sum of a column of numbers to an adjacent 

cell, will add up the adjacent column of cells.  The formula has updated automatically to 

refer to adjacent cells. This is an example of a relative referencing system. 

Sometimes we may need to refer to a specific cell location in a worksheet, and so we 

want that cell reference to remain unchanged, regardless of where the formula is placed. 

We need a method to fix our cell reference so that it does not update when we copy the 

formula to another location – we need an absolute cell reference. 

Making a reference absolute 

Type a $ sign before both the column letter and the row number of the cell reference. E.g. 

the relative reference A1 becomes the absolute reference $A$1.   

or use the keyboard shortcut, F4.  

1. In the Formula bar, highlight the cell reference for the cell which is to be made 

absolute. 

2. Press F4.  

 

$ signs are automatically placed in front of the column and row references. 
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Making a mixed reference 

If only the columns or the rows are to be absolute, prefix one or other of these with a $ 

sign. For example, if the column is to be absolute and the row relative A1 becomes $A1, 

if the row is to be absolute and the column relative A1 becomes 

A$1. 

1. Double-click in the cell as if to edit it. 

2. Highlight the cell reference to be made absolute and press F4. 

Note that by pressing F4 a number of times you cycle through 

different options for creating a mixed reference. 

 

 

Absolute references explained 

The data, to the left, show the basic earnings for a group of 

staff.  Their manager has decided to award them a bonus 

payment, and wishes to store 

the total pay in column C.  

The formula for cell C6 is  

=(B6+$B$3). Here the $ is used 

to make the reference to cell B3 

absolute. When this formula is 

copied into cells C7:C12, the formula updates as shown. 

Working with Names  

It is easy to lose track of what information particular cells or ranges of cells in a 

worksheet contain, particularly in a large worksheet. Referring to a cell (or range of cells) 

by its cell address (e.g. A1, G19, C25:C65) is not very intuitive. To help the user of a 

worksheet, Excel allows you to create a Name to refer to a cell, a group of cells, a value 

or a formula. 

 A name is easier to remember than a cell reference. 

 You can use a named reference almost anywhere you might use a regular reference, 

including in formulae and dialog boxes. 

 A1 Relative 

 $A$1 Absolute 

 $A1 Mixed 

 A$1 Mixed 

A$1 Mixed 
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 Formulae that use names are easier to read and remember than formulae using cell 

references. For example, the formula: 

     =Assets-Liabilities   

      is clearer to read and understand than the formula: =F6-G6 

 Excel can automatically create names for cells based on row or column titles in your 

spreadsheet, or you can enter names for cells or formulae yourself. 

 If you name a cell you are likely to need to use in an absolute reference, it will save you 

from using the $ symbol in the cell reference, as you will simply need to refer to the 

cell name. 

Default names 

By default, every cell has a unique name – the cell address (A1, F4 etc.). When you select 

a cell, its name appears in the Name Box.  

It is possible to move directly to a cell location simply by typing the cell name into the 

Name Box and pressing Enter. 

Naming rules 

Names are unique within a workbook and the names that you choose to use must adhere 

to certain rules.  

 The first character of a name must be a letter or an underscore character. Remaining 

characters in the name can be letters, numbers, full stops, and underscore characters.  

 Names cannot be the same as a cell reference, such as Z$100 or R1C1. 

 Spaces are not allowed. Underscore characters and full stops may be used as word 

separators – for example, First.Quarter or Sales_Tax. 

 A name can contain up to 255 characters. 

Names can contain uppercase and lowercase letters. Excel does not distinguish between 

uppercase and lowercase characters in names. For example, if you have created the name 

Sales and then create another name called SALES in the same workbook, the second 

name will replace the first one. 

Creating a Name 

1. Select the cell or cells you 

want to name. 
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2. Click in the Name box and type a name. 

3. Press Enter. 

 

Defining names 

You will often find that the names you want to use for your cells are the same as the 

headings you have given them in your worksheet.  When this is the case, you can save 

yourself some typing by using Define Name to set them up.  With the Define Name 

command, Excel looks at the cells around those selected and if it finds a label, it proposes 

that you use it as your name.  You can still overwrite Excel‘s proposal if it chooses 

something inappropriate. 

1. Select the cell or cells you want to name. 

2. From the Insert menu, select Name and then Define.  The following dialog box will 

appear: 

 

The Names in workbook box will contain the name Excel proposes for the selection.  

The Refers to box (at the bottom of the dialog box) will show the range of the 

selected cells. 

3. Click OK to accept Excel‘s proposed name and close the dialog box. 

or 

Type the name you want to use. 
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Click OK to set the name up and close the dialog box. 

Creating multiple names 

When you want to use column and row headings on a worksheet to set up names for data, 

you don‘t have to do them one by 

one.  In the example below, it would 

be useful to set up names for the 

different stationery items and the 

different column headings.  You can 

create them all at once using Create Names. 

1. Select the range for which you want to set names up, including the column and/or row 

headings to be used as names. 

2. From the Insert menu, select Name, and then Create.  The 

following dialog box will appear: 

3. Excel will guess which edges of the selection contain the 

labels you want to use. However, you can change the 

options by checking and unchecking the boxes until the 

correct edges are selected. 

4. Click OK to set the names up. 

When you select a named range, its name appears in the Name Box. 

Selecting names 

Once you have created names in a workbook, you can quickly move to them either using 

the Name Box or F5 (GoTo key). 

1. Click the drop-down list arrow to the right of the Name Box. 

2. Choose the name you want to select by clicking it with the mouse. 

3. The screen display will jump to the range you chose and select the cells 

within it. 

or 

1. Press F5 to access the GoTo dialog box. 

2. Press Tab to select the first item in the GoTo list. 

3. Use the arrow keys to move the highlight bar up and down the list of defined names. 

4. Press Enter to move to the selected name. 
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Names in formulae 

Because names make selecting and referring to cells much easier, it makes sense to use 

them in formulae.  

The other advantage 

that they have over 

cell references is that 

names are absolute.  

This means that you 

don‘t have to worry 

about copying 

formulae that refer to 

names. 

 

To use names in a formula: 

1. Move to the cell where you want the formula and begin typing it – all formulae begin 

with an equals (=) sign. 

2. When you want to use the name, press F3 to 

access the Paste Name dialog box. 

3. Use the up and down arrow keys to highlight 

the name you want in your formula. 

4. Press Enter to close the dialog box and paste 

the name into the formula. 

If you can remember what you called your ranges when you named them, you can simply 

type the names into the formula. 

Applying names 

There may be occasions where you already had formulae and functions set up in a 

workbook before you created any names.  This might mean that there are formulae 

referring to cell references that you have subsequently given names to.  You can apply 

names to formulae even if you created them after the formulae themselves were set up. 

1. Select the cell or cells containing the formulae whose references you want to replace 

with names. 
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2. From the Insert menu, click Name and then 

Apply.  The following dialog box will appear: 

3. Excel will pick those names it thinks relevant to 

your selection, however, you can select or 

deselect other names in the list by clicking on 

them. 

4. When all names to be applied have been selected, 

click OK to apply the names and close the dialog box.  When you look at your 

formulae, you should find that anywhere there were references to named ranges; 

Excel has replaced the cell references with the names. 

Deleting Names 

You can delete names from your workbook if you are no longer using them. 

1. From the Insert menu, select Name then Define.  The Define Name dialog box will 

appear.  Any names in the currently opened files appear listed. 

2. Click the name you want to delete. 

3. Click the Delete button then click the OK button to close the dialog box. 

4. If you delete a name that is being used in formulae, Excel will display #NAME? in 

the cell containing those formulae. (You can use the Edit|Undo feature to reinstate the 

name.) 

Paste List 

You can use the Paste Names dialog box to give you an index of all the names in your 

workbook.  Excel will place this on the workbook wherever the active cell is positioned. 

1. Select a blank cell where you want the list of names to begin. 

2. Press F3 to access the Paste 

Names dialog box. 

3. Click the Paste List button. 

or 

press Tab to jump to the Cancel 

button, then Tab again to select the 

Paste List button. 

The list will appear on the worksheet. 
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When you choose a start cell for your pasted list, make sure there isn‘t any data 

immediately below, as it will get cleared when you paste the list. 

 

Conditional Functions 

Occasionally you may need to create a total that only includes certain cells, or count only 

certain cells in a column or row.  The only way you could do this is by using functions 

that have conditions built into them.  A condition is simply a test you can ask Excel to 

carry out, the result of which will determine the result of the function. 

Counting and totaling cells conditionally  

SUMIF() 

You can use this function to say to Excel, 

―only total the numbers in the Total 

column where the entry in the Course 

column is ―Word Intro‖.   

The syntax of the SUMIF() function is 

detailed below: 

=SUMIF(range,criteria,sum_range) 

Range is the range of cells you want to test. 

Criteria are the criteria in the form of a number, expression, or text that defines which 

cells will be added.  

Sum_range are the actual cells to sum.  The cells in sum_range are summed only if their 

corresponding cells in range match the criteria. If sum_range is omitted, the cells in 

range are summed. 

Using the example above the SUMIF() function would be as follows: 

=SUMIF(B4:B23,"Word Intro",C4:C23) 

COUNTIF() 

The COUNTIF function allows you to count those cells that meet a certain condition. The 

function syntax is as follows: 
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=COUNTIF(range,criteria) 

Range is the range of cells from which you want to count cells. 

Criteria are the criteria in the form of a number, expression, or text that defines which 

cells will be counted. For example, criteria can be expressed as 32, "32", ">32", "apples".  

With our example (shown above), the COUNTIF function you could use to determine the 

number of Word Intro courses run would be:     

 =COUNTIF(B4:B23, ―Word Intro‖) or =COUNTIF(B4:B23, E4) 

Understanding error messages 

Excel may display error messages if your formulae or functions contain mistakes (note 

that it will not detect all errors in calculations). It is always worth checking the result of 

your formulae by hand if the formula is at all complex. Excel‘s error messages contain a 

# symbol followed by a diagnostic word (see the table below). In some cases, the cell 

with an error in it has a small green arrow in the corner. In such cases, if you click in the 

cell a yellow symbol with an exclamation mark appears.  Click the exclamation mark for 

options to help you to trace the source of the error. 

                 

            Green triangle Cell containing error message 

 

Yellow symbol with exclamation mark 
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Options for dealing with error 

Typical errors and their causes 

###### The column is not wide enough to display data (for numbers). 

Date or time may be negative. 

#VALUE! Occurs when the wrong type of argument is used in a function or 

formula. For example, there is text in a formula that requires a number 

or logical value. 

#DIV/0! Occurs when a number is divided by zero. 

#NAME? Occurs when Excel doesn‘t recognize text in a formula (e.g. 

misspelling a function name or cell reference).  

#N/A Occurs when a value is not available to a formula or function – perhaps 

data are missing. 

#REF! Occurs when a cell reference is not valid – perhaps the cell has been 

deleted. 

#NUM! Occurs when a number is invalid – perhaps a price has been entered 

with the £ sign, or a formula results in a number too big or too small 

for Excel to display. 

Circular 

reference 

 

This happens when the formula points to the cell in which the result is 

to be displayed, e.g., placing the formula =SUM(A1:A2) into cell A2. 

 

Viewing formulae 

Sometimes you may want to view the actual formulae in your worksheet, rather than the 

numerical results of the formulae. This can be particularly useful if you are getting error 

messages and need to examine the formulae. To view the formulae: 

1. From the Tools menu choose Options to reveal the Options window. 
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2. Select the View tab, and click the Formulas check box and OK. 

 

3. All formulae in the worksheet will display in full as shown below (this can be useful 

for trouble-shooting if your calculations do not seem to be working – you can print 

out the formulae for closer inspection). Notice how the columns automatically widen 

to accommodate the formula. 

4. You can turn off the formula display using the same check box in the Options 

window. Notice how the columns shrink again to their original width. 

You can Press Ctrl and ` (the open single inverted comma key, usually found to the left 

of the number 1 key on the top row of your keyboard). You can toggle between formulae 

and values by pressing Ctrl+` repeatedly. 

 
DATABASE FUNCTIONS IN SPREADSHEET 
Database   is the range of cells that makes up the list or database. A database is a list of 

related data in which rows of related information are records, and columns of data are 

fields. The first row of the list contains labels for each column. The following are some of 

the database functions supported by Excel 

Formulas 
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Function Description 

DAVERAGE  Returns the average of selected database entries 

DCOUNT  Counts the cells that contain numbers in a database 

DCOUNTA  Counts nonblank cells in a database 

DGET  Extracts from a database a single record that matches the specified 

criteria 

DMAX Returns the maximum value from selected database entries 

DMIN Returns the minimum value from selected database entries 

DPRODUCT  Multiplies the values in a particular field of records that match the 

criteria in a database 

DSTDEV  Estimates the standard deviation based on a sample of selected 

database entries 

DSTDEVP  Calculates the standard deviation based on the entire population of 

selected database entries 

DSUM  Adds the numbers in the field column of records in the database that 

match the criteria 

DVAR  Estimates variance based on a sample from selected database entries 

DVARP  Calculates variance based on the entire population of selected database 

entries 

GRAPHICS ON SPREADSHEET 

As the common saying goes 'A picture is worth a thousand words' is found true by 

almost all of us. Any kind of message can be best said and understood through its 

representation in pictorial form.  
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Creating Charts 

Patterns and relationships between numbers are often easier to recognize when 

they are displayed in form of chart. An Excel chart may be placed inside of a worksheet 

next to the data, or placed in a separate worksheet. Excel charts can also be copied to 

other software programs such as PowerPoint. 

Types of Charts 

Before selecting the data you wish to graph, it's helpful to have an idea of what 

chart type would best display your data. The type of data to be charted often determines 

the chart type. 

If multiple chart types can be used for your data, choose the chart type that will 

help the user best visualize the patterns and relationships between the data values. 

The 4 most popular chart types in Excel are described below, along with the best use of 

each chart type. A "series" is a group of related values, such as "student grades" or 

"quantity. 

Type Image Description When to Use 

Pie 

Chart 
 

Displays the percentages 

of a whole for each 

member in a series. 

Excellent chart for comparing 

values in a single series as 

percentages of whole. 

Column 

Chart 
 

Using vertical columns, 

displays values for one or 

more series over time or 

other category. 

Especially effective in comparing 

values for multiple series. The 3-

D Column chart displays multiple 

series over three axes (X, Y, and 

Z). 

Bar 

Chart 
 

Displays values for one or 

more series using 

horizontal columns. 

Though useful for single or 

multiple series, this chart type 

especially effective in comparing 

large quantity of values in a single 
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Type Image Description When to Use 

series. 

Line 

Chart 
 

Displays values as equally 

spaced points connected 

with a line. 

This chart is most useful 

displaying trends over time or 

other ordered category for single 

or multiple data series. 

Selecting Data for an Excel Chart 

 

First, select the cells that contain the values you want shown in the chart. Click and drag 

the cursor from the top left cell to the bottom right cell of the worksheet - including 

column and row headings when possible. If your worksheet has a Totals column like in 

our worksheet above (e.g. Year), this data is typically not charted. 

Non-contiguous rows and columns of cells can be selected by pressing and holding the 

Ctrl key while selecting each group of cells. 

A data series is a related set of data points. In the image above, we selected a single 

series, Flowers. It is outlined in red. Many chart types allow us to plot multiple series. If 

we had selected Flowers, Shrubs, and Trees, we would be charting 3 series. 

Create a Chart in Excel  

Click  Insert | Chart. The Chart Wizard appears. 

Step 1: Click the desired chart type in the left column, and click one of the chart sub-

types in the right column. Click Next. 
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Step 2: Excel assumes you wish to keep the series data in rows. You may click 

"Columns" to see how the chart changes. When finished, click Next. 

 

Step 3: Type a chart title. If you wish to add a title for the axes, do so. Then click Next. 
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Step 4: Excel assumes you want the chart placed on the worksheet. If you would like the 

chart placed in a new sheet, click the radio button, type a sheet name, and click Finish. 
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Deleting, Moving, and Resizing Charts 

To select an existing chart, click on its border, or click in an empty space inside the chart. 

When selecting a chart, be careful not to click on an element inside the chart or that 

element will be selected instead. 

How to Delete a Chart 

To delete a chart that has just been created, click the Excel Undo button. To delete an 

existing chart, select the chart and press the Delete key, or right-click and select Cut. 

How to Move a Chart 

To move a chart to a different place on the worksheet, select the chart and drag it to the 

desired location. 

To move a chart to a new or different spreadsheet in the same workbook, select the chart, 

right-click, and select Move Chart. Then choose the sheet or type in a new sheet name, 

and click OK. 

How to Resize a Chart 

To resize a chart, select the chart and drag any of the chart's corners. 

Excel Chart Helpful Hints 

For best results, keep the Excel chart simple and uncluttered. It is better to use multiple 

charts to express patterns and relationships between data than to use one chart that is too 

busy and over-complicated. 

A colorful chart is ideal for online presentations or for printing on a color printer. But 

shades of gray are best for monochrome printing of charts. 
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Unit 5 – Managerial Applications of 
Computers 

Computers do more than help businesses create professional looking slides and print sales 

reports. Because computers can often automate time-consuming tasks that humans 

perform, software developers create programs that solve a variety of problems. Whether 

you‘re a sole proprietor selling jewelry or a global conglomerate such as Sony, you‘ll 

benefit by learning to use computers to help you manage your business. 

COMPUTERS AND MANAGEMENT FUNCTIONS 

Data Management 

Data management activities form the foundation for many activities that businesses 

perform. Computers make it possible for companies to organize and manipulate massive 

amounts of information productively. Larger corporations may use multiple SQL Server 

databases to oversee data operations while smaller businesses might take advantage of the 

data manipulation features in applications such as Microsoft Access. Regardless of your 

business's size, you probably work with information and need to store it. Business 

websites also use database software to sell products and even give people the ability to 

join their sites. If you a have a website, you can set up data management software 

yourself or hire a company to manage it for you. 

Office and Supply Management 

Companies make money by buying and selling products at a profit, and computers help 

them manage inventory and supplies efficiently. Wal-Mart, for example, uses a 

sophisticated NeoVista inventory management software system that enables the company 

to keep products available in stores when people need them. Computers are also useful 

for helping smaller businesses track and manage basic supplies, such as printer paper, 

pencils and even cups for the water cooler. 
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People Management 

Communicating with a coworker who is sitting in the next cubicle is rarely a problem, but 

coordinating and managing meetings where people reside in different states can be a 

challenge. Computer software enables businesses to conduct virtual meetings where 

people meet over the Internet and makes it possible for everyone in the business to view a 

common calendar. Some companies strive to increase productivity by monitoring the 

computers that people use. Monitoring enables companies to track billable hours and 

identify activities that may be unprofitable. If you do any kind of time tracking or 

meeting planning, scheduling and calendar software can help you. 

Record Keeping and Accounting 

When tax time arrives, you can be prepared by accessing financial records that you've 

kept during the year on a computer. Accounting software helps people manage money, 

create budgets, track sales and monitor resource usage. Products such as QuickBooks, 

Quicken and NetSuite provide accounting solutions for businesses of all sizes. Look for 

accounting programs that can access the Web if members in your organization need to 

access and share accounting information from multiple locations. You‘ll also find 

spreadsheet programs useful for doing everything from creating time sheets to managing 

payroll. 

COMPUTER BASED FINANCIAL ACCOUNTING 

SYSTEM 

The Financial Accounting System (FAS) is the heart of the overall distribution 

system. Its functions as a traffic cop to route financial information in the correct file or 

account. Financial accounting is an art of recording and processing all transactions within 

an organization with outsiders and includes events affecting the financial position of the 

organization. It results in preparation of the annual profit and loss account as well as 

balance sheet for the organization. 

Why Computerized FAS? 

The control of funds coming into and going out of the firm is obviously very important 

and the use of computers should make such control more effective. A great volume of 

accounting data is numerical and is always processed with the same method. This makes 
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computerization relatively easy. Calculations should be more accurate. Reports can be 

supplied faster and frequently. 

 

 The Accounting System 

Accounting is the method in which financial information is gathered, processed, and 

summarized into financial statements and reports. An accounting system can be 

represented by the following graphic. 

 
Figure 16 Accounting system 

 

The purpose of accounting is to provide information used in decision making. 

Accounting may be viewed as a system (a process) that converts data into useful 

information. 

Information processes include: 

 Recording 

 Maintaining 

 Reporting 

Every business has numerous processes. Some may be simple, other complex and 

cumbersome. But as the business grows, acquires new customers, enters new markets and 

keeps pace with constant changes in statutory regulations... the company will need to 

maintain highly accurate and up-to-date accounting, inventory and statutory records.  

This is where a computerized accounting helps simplify, integrate, and streamline all the 

business processes, cost-effectively and easily. 
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Salient Features of Computerized accounting 

Fast, Powerful, Simple and Integrated 

Computerized accounting is designed to automate and integrate all the business 

operations, such as sales, finance, purchase, inventory and manufacturing. With 

Computerized accounting, accurate, up-to-date business information is literally at the 

fingertips. The Computerized accounting combine with enhanced MIS, Multi-lingual and 

Data organization capabilities to help the company simplify all the business processes 

easily and cost-effectively. 

Complete Visibility 

Computerized accountings giving the company sufficient time to plan, increase the 

customer base, and enhance customer satisfaction. With Computerized accounting the 

company will have greater visibility into the day-to-day business operations and access to 

vital information. 

Enhanced User Experience 

Computerized accounting allows the company to enter data in a variety of ways which 

makes work a pleasure. Adapting to the specific business needs is possible. 

Accuracy, Speed 

Computerized accounting has User-definable templates which provides fast, accurate data 

entry of the transactions; thereafter all documents and reports can be generated 

automatically, at the press of a button. 

Scalability 

Computerized accounting adapts to the current and future needs of the business, 

irrespective of its size or style. 

Power 

Computerized accounting has the ability to handle huge volumes of transactions without 

compromising on speed or efficiency. 

For Improved Business Performance 

Computerized accounting is a highly integrated application that transforms the business 

processes with its performance enhancing features which encompass accounting, 

inventory, reporting and statutory processes. This helps the company access information 
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faster, and takes quicker decisions. Computerized accounting also guarantees real-time 

optimization of operations and enhanced communication. 

Quick Decision Making 

Generates real-time, comprehensive MIS reports and ensures access to complete and 

critical information, instantly. 

Complete Reliability 

Computerized accounting makes sure that the critical financial information is accurate, 

controlled and safe from data corruption. 

Advantages of Computerized accounting 

 Automation of tedious clerical jobs 

 Speed and accuracy 

 Low cost of packages 

 Automatic generation of standard reports 

 Redundant data storage permits efficient generations of some reports 

 Increase revenue while lowering operating costs and enhancing competitive 

advantage of the company. 

Disadvantages of Computerized accounting 

 Transactions orientation only 

 Periodic not real time reporting 

 Limited flexibility for ad hoc reports 

COMPUTERISED INVENTORY CONTROL SYSTEM  

A Computerized Inventory Control System is the integration of sub-functions 

involved in the management of inventory into a single cohesive system. It is software 

installed on the computer systems that enables a firm to keep a check on the inventory 

levels by performing the automatic counting of inventories, recording withdrawals and 

revising the stock balance. 

It is very difficult for any firm to maintain a large stock of inventories, and therefore, 

many firms have adopted the Inventory Control System in terms of Minimum and 

Maximum limit for the stock. There is an inbuilt system for placing orders in computer 

systems that automatically generates a PO to the supplier when the minimum level of the 

stock or the reorder point is reached. 
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The benefits of a computerized inventory control system can be derived, when the 

business integrates its inventory control system with the other systems such as accounting 

and sales, which helps in better control of inventory levels. 

In practice, when the inventory level reaches to its minimum point, the system 

automatically generates a purchase order, which will be sent to the supplier 

electronically. Also, the other copy of the PO is sent to the accounting department. Once 

the material is received from the supplier, an inventory gets updated on the system and at 

the same time, the notification is sent to the accounting department, which is used against 

the supplier‘s Invoice and the PO copy. 

Thus, a computerized inventory control system has made a life of both the manufacturer 

and the big retailer easy, who can manage their inventories electronically without wasting 

much time on the manual tracking system. Also, all the documents, such as purchase 

order, Invoice, account statement gets automatically generated with a use of 

computerized inventory control system. 

But however, too much reliance on the technology may be problematic in the situations 

of power failure and lost internet connectivity, as it may bring a system to a standstill. 

Also, the accuracy of inventory items inserted in the system depends on the data entry 

made by the person. Thus, a proper entry should be made to obtain the correct inventory 

levels. 

COMPUTERIZED MIS AND CONTROL SYSTEM 

Management Information System or 'MIS' is a planned system of collecting, 

storing, and disseminating data in the form of information needed to carry out the 

functions of management. 

To the managers, Management Information System is an implementation of the 

organizational systems and procedures. To programmer it is nothing but a file structure 

and file processing. However, it involves much more complexity. 

The three components of MIS provide a more complete and focused definition, 

where System suggests integration and holistic view, Information stands for processed 

data, and Management is the ultimate user, the decision makers. 

Management information system can thus be analyzed as follows: 
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Management 

Management covers the planning, control, and administration of the operations of a 

concern. The top management handles planning; the middle management concentrates on 

controlling; and the lower management is concerned with actual administration. 

Information 

Information, in MIS, means the processed data that helps the management in planning, 

controlling and operations. Data means all the facts arising out of the operations of the 

concern. Data is processed i.e. recorded, summarized, compared and finally presented to 

the management in the form of MIS report. 

System 

Data is processed into information with the help of a system. A system is made up of 

inputs, processing, output and feedback or control. 

Thus MIS means a system for processing data in order to give proper information to the 

management for performing its functions. 

Objectives of MIS 

The goals of an MIS are to implement the organizational structure and dynamics of the 

enterprise for the purpose of managing the organization in a better way and capturing the 

potential of the information system for competitive advantage. 

Following are the basic objectives of an MIS: 

 Capturing Data: Capturing contextual data, or operational information that will 

contribute in decision making from various internal and external sources of 

organization. 

 Processing Data: The captured data is processed into information needed for 

planning, organizing, coordinating, directing and controlling functionalities at 

strategic, tactical and operational level. Processing data means: 

o making calculations with the data 

o sorting data 

o classifying data and 

o summarizing data 
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 Information Storage: Information or processed data need to be stored for future 

use. 

 Information Retrieval: The system should be able to retrieve this information 

from the storage as and when required by various users. 

 Information Propagation: Information or the finished product of the MIS should 

be circulated to its users periodically using the organizational network. 

Characteristics of MIS 

Following are the characteristics of an MIS: 

 It should be based on a long-term planning. 

 It should provide a holistic view of the dynamics and the structure of the 

organization. 

 It should work as a complete and comprehensive system covering all 

interconnecting sub-systems within the organization. 

 It should be planned in a top-down way, as the decision makers or the 

management should actively take part and provide clear direction at the 

development stage of the MIS. 

 It should be based on need of strategic, operational and tactical information of 

managers of an organization. 

 It should also take care of exceptional situations by reporting such situations. 

 It should be able to make forecasts and estimates, and generate advanced 

information, thus providing a competitive advantage. Decision makers can take 

actions on the basis of such predictions. 

 It should create linkage between all sub-systems within the organization, so that 

the decision makers can take the right decision based on an integrated view. 

 It should allow easy flow of information through various sub-systems, thus 

avoiding redundancy and duplicity of data. It should simplify the operations with 

as much practicability as possible. 

 Although the MIS is an integrated, complete system, it should be made in such a 

flexible way that it could be easily split into smaller sub-systems as and when 

required. 

 A central database is the backbone of a well-built MIS. 

Characteristics of Computerized MIS 
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Following are the characteristics of a well-designed computerized MIS: 

 It should be able to process data accurately and with high speed, using various 

techniques like operations research, simulation, heuristics, etc. 

 It should be able to collect, organize, manipulate, and update large amount of raw 

data of both related and unrelated nature, coming from various internal and 

external sources at different periods of time. 

 It should provide real time information on ongoing events without any delay. 

 It should support various output formats and follow latest rules and regulations in 

practice. 

 It should provide organized and relevant information for all levels of 

management: strategic, operational, and tactical. 

 It should aim at extreme flexibility in data storage and retrieval.   
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